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EEDDIITTOORRIIAALL

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE!

We have the usual Python, LibreOffice, Inkscape and Blender HowTo's. Joining them
this month is an extensive HowTo on the genealogy app Personal Ancestral File. A

Windows app! Fear not, David O. Rowell shows you how to install it using Wine, then how to
use PAF for entering your family history. Yes, Linux has GRAMPS, but there's not much else
should you need an alternative. Thankfully, PAF works pretty flawlessly using Wine.

No doubt you've all heard about Ubuntu for phones and tablets by now. This month, we
have two articles dealing with just that. First is Lucas (Command and Conquer) who
discusses what it is. Later in the issue, Copil (Ask The New Guy) mentions it in his roundup
of what else Ubuntu has to offer and what its future might hold.

Need something to keep the kids busy over the coming holidays? Check out Copil's
review of Python For Kids (from No Starch Press). And, if Copil can understand it, your kids
will find it a breeze. Just kidding, Copil! On the subject of reviews, you might like Art's
review of Chrome OS. Is it even a threat to Windows or OSX? Art thinks so. So much so that
it might even be a threat to our beloved Linux! Speaking of crazy things, I'm hoping that the
opinion piece from Knightwise will prompt some discussion (the one from former FCM
podcaster Ed didn't). He even mentions Windows. I told you he was crazy!

As ever, keep sending in your articles, desktop screens, reviews, stories, opinions, and
anything else Linux related.

All the best, and keep in touch!
Ronnie

ronnie@fullcirclemagazine.org

This magazine was created using :

Full Circle Podcast
Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

http://fullcirclemagazine.org

mailto:ronnie@fullcirclemagazine.org
http://www.scribus.net
http://www.gimp.org
http://www.libreoffice.org
http://creativecommons.org/
http://fullcirclemagazine.org
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UUBBUUNNTTUU NNEEWWSS
Written by The Ubuntu News Team

UBUNTU UNVEILS TABLET

EXPERIENCE WITH MULTI-
TASKING

This week Canonical announced
the availability of an SDK for

Ubuntu for tablets. Ubuntu for
tablets provides manufacturers
with an alternative to Android that
can be managed with the same
tools as Ubuntu server or desktop.
Ubuntu for tablets is an elegant,
non-fragmented solution that
provides a secure multi-user
experience.
http://www.canonical.com/content
/ubuntu-unveils-tablet-experience-
multi-tasking

RELEASING THE UBUNTU

TOUCH DEVELOPER PREVIEW

AND SDK ALPHA AND

TAKING UBUNTU TOUCH

DEVELOPER PREVIEW TO

NEW LEVELS

David Planella and Daniel
Holbach write about the new

Ubuntu Touch Developer Preview

which can be used in the Galaxy
Nexus, Nexus 4, Nexus 7, and
Nexus 10 devices. They also
mention the features included as
well as a guide on how to
contribute to the current project.
http://developer.ubuntu.com/2013
/02/releasing-the-ubuntu-touch-
developer-preview-and-sdk-alpha/

http://developer.ubuntu.com/2013
/02/taking-ubuntu-touch-to-new-
levels/

UBUNTU DEVELOPER

SUMMITS NOW ONLINE AND

EVERY THREE MONTHS

Jono Bacon announces a change
to the Ubuntu Developer

Summit schedule which will be
exclusively online and take place
every three months, writing that
the “new format of UDS provides
an enhanced level of openness and
transparency that is optimized for
online participants.” Bacon
announces that the “first online
UDS will be taking place next week
on March 5th-6th, 2013 from 2pm
UTC – 8pm UTC, and the next event

will take place around the same
time as the originally scheduled
physical UDS in Oakland.”
http://fridge.ubuntu.com/2013/02/
26/ubuntu-developer-summits-
now-online-and-every-three-
months/

LET'S DISCUSS INTERIM

RELEASES (AND A ROLLING

RELEASE)

Rick Spencer kicks off
discussion about the Ubuntu

development list of a proposals
which suggests “dropping non-LTS
releases and move to a rolling
release plus LTS releases right
now.”
https://lists.ubuntu.com/archives/u
buntu-devel/2013-
February/036537.html

MIR + UNITY QML + UNITY

APIS = UNITY

Olli Ries, Engineering Director
for Unity and Display Server

at Canonical, announces and shares
some insights about the Mir

display server and Unity QML.
According to what Ries calls their
ambitious goal, Unity will
transition back to Qt/QML, and Mir
will replace Xserver in 2013.
http://fridge.ubuntu.com/2013/03/
04/mir-unity-qml-unity-apis-unity/

NOT CONVINCED BY ROLLING

RELEASES

Mark Shuttleworth, responded
to the case of rolling

releases. Shuttleworth expresses
that he is not convinced of the idea
as it injects uncertainty where
certainty is needed, among other
issues. The proposal rose up again
this year and Shuttleworth allowed
the core engineering team at
Canonical to create a “trial
balloon” proposal. Shuttleworth
noted that the proposal put
forward by Rick Spencer was not
final action as it was not put
forward to the Technical Board and
that, though the Community
Council was briefed on it, they had
not taken action either.

Shuttleworth indicated that

http://www.canonical.com/content/ubuntu-unveils-tablet-experience-multi-tasking
http://developer.ubuntu.com/2013/02/releasing-the-ubuntu-touch-developer-preview-and-sdk-alpha/
http://developer.ubuntu.com/2013/02/taking-ubuntu-touch-to-new-levels/
http://fridge.ubuntu.com/2013/02/26/ubuntu-developer-summits-now-online-and-every-three-months/
https://lists.ubuntu.com/archives/ubuntu-devel/2013-February/036537.html
http://fridge.ubuntu.com/2013/03/04/mir-unity-qml-unity-apis-unity/
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UBUNTU NEWS
there were unexpected findings by
the team putting the proposal
together. The releases, the
mechanisms for releases, and the
release paradigms all presented
conundrums that needed to be
untangled. Shuttleworth also
indicated that some expectations
expressed by stakeholders, such as
providing support for PowerPC
architecture, were unrealistic
based on the nature of today’s
consumer market.

Beyond that, Shuttleworth
called for an end to what he
termed as “melodrama” and
indicated that the “sky was not
falling.” While noting that there
has been a paradigm shift from
integration to leadership,
Shuttleworth also stated that
those who feel the need to move
on should not “poison the well
behind them.” Shuttleworth noted
that there is now - what he calls - a
once-in-a-lifetime opportunity for
Ubuntu to dominate in the
consumer electronics space, and it
is time to strike while the iron is
hot.

The post ends with questions to
try to steer the discussion back
into debating the rolling release
proposal prior to it being

submitted to the Technical Board
later in March.
http://www.markshuttleworth.com
/archives/1228

13.04 (RARING RINGTAIL)
BETA 1 RELEASED!

Stéphane Graber, on behalf of
the Ubuntu release team,

announces the release of the 13.04
(Raring Ringtail) Beta 1.

Beta 1 includes a number of
software updates that are ready
for wider testing. This is an early
set of images, so you should
expect some bugs. For a more
detailed description of the changes
in the Beta 1 release and the
known bugs (which can save you
the effort of reporting a duplicate
bug, or help you find proven
workarounds), please see:
http://www.ubuntu.com/testing/

Full announcement here:
https://lists.ubuntu.com/archives/u
buntu-devel-announce/2013-
March/001024.html

UBUNTU GNOME IS

APPROVED AS AN OFFICIAL

FLAVOUR

Tim Lunn announces, on behalf
of the Ubuntu GNOME

developers, that their flavour,
which “aims to bring a mostly pure
GNOME desktop experience to
Ubuntu.Ubuntu GNOME Remix”
has been accepted as an official
flavour by the Ubuntu Technical
Board.

Congratulations to the Ubuntu
GNOME developers!

https://lists.ubuntu.com/archives/u
buntu-gnome/2013-
March/000035.html

MANY THANKS TO THE

UBUNTU NEWS TEAM FOR

THEIR CONTRIBUTION THIS

MONTH.

News this month comes from:

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue305

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue306

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue307

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue308

http://blog.canonical.com/?p=2171
http://www.markshuttleworth.com/archives/1228
http://www.ubuntu.com/testing/
https://lists.ubuntu.com/archives/ubuntu-devel-announce/2013-March/001024.html
https://lists.ubuntu.com/archives/ubuntu-gnome/2013-March/000035.html
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue305
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue306
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue307
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue308
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I originally wanted to write this
article on my first impressions

for the developer preview of
Ubuntu Touch. However, as I
couldn't get the work-in-progress
version working on my TF101 (Asus
Transformer), and as I wasn't
willing to sacrifice my brand new
Nexus 7's warranty (and data) to
test a very basic version of Ubuntu
Touch, I had to head back to the
drawing board. When sharing my
situation with Ronnie, we ended
up having a discussion on whether
or not Ubuntu Touch would be
replacing Android for us. Ronnie
was skeptical about it, while I was
fairly open to the idea. Long story
short, I decided to write up my
opinions on why Ubuntu Touch
could be interesting to mobile
users, and why it might not
manage to lure you away from
Android. I will be ignoring any
other mobile operating systems, as
Ubuntu Touch can, at least for the
moment, be installed on only
Android devices. For those of you
who were expecting my typical
how-to articles: they should be
back as of the next issue!

WHAT IS UBUNTU TOUCH?

For those of you who missed
the announcements, Ubuntu Touch
is a version of Ubuntu being
developed for android-based
devices with screen sizes between
4” and 10” screens. The Further
Reading section has links to the
official announcement pages. A
few interesting features that the
end product is aiming to have are
as follows:

• The ability to dock to a keyboard,
mouse and screen for a full Ubuntu
desktop experience (similar to
Ubuntu for Android).
• The ability to
seamlessly move
work between
devices
(phone,
tablet, TV,
desktop).
• Utilize the
entire screen
space
(accomplished
by utilizing
swiping in from
edges, and hiding the

interface buttons and options until
required).
• A lock screen that is “tailored to
you”. Essentially, the lock screen
should display information
relevant to you based on your
frequent tasks.
•Minimize steps in order to get to
the apps you want. For example,
the app tray is revealed by swiping
in from the left side, regardless of
where you are (even on the lock
screen), allowing you to jump
straight into the application,
instead of having to first unlock
and then locate the launcher for
the app.

• Ability to run phone apps
(such as

texting/chatting)
alongside tablet

apps (media
applications,
video chat,
etc.). This is
available
only for the

larger screen
sizes, but

appeals greatly
to me, who is an

avid tiling window

manager user.

There are, of course, many
other features too. However, these
are the ones that had me nodding
along in agreement when they
were presented.

WHAT'S KEEPING YOU ON

ANDROID?

I used an Asus Transformer
TF101 for a good couple of years,
and only recently replaced it with a
Google Nexus 7. While I mainly
used either device for productive
tasks (checking email, testing
websites, reading articles or books,
and, occasionally, for writing up
notes/articles), I did occasionally
enjoy a game or two. Productivity
tasks should be as easily
accomplished on Ubuntu Touch as
on any Ubuntu desktop, or any
Android device. The “problem” lies
with those apps that occupy roles
we wouldn't usually associate with
desktops. This includes
touchscreen-based games (for
example, the Simpsons Tapped
Out, Draw Something, or anything

CCOOMMMMAANNDD && CCOONNQQUUEERR
Written by Lucas Westermann

UUbbuunnttuu TToouucchh
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Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

of the sort), and any productivity
apps that were developed with a
touchscreen device in mind. Due to
the fact that Ubuntu Touch is
aiming to offer desktop
applications which can be found in
Ubuntu on a mobile device, many
applications geared towards the
mobile will probably be more
error-prone when the first devices
are released. This is simply due to
the fact that Ubuntu Touch is new,
while Android has been around for
a number of years now. As such,
some apps are more matured, and
could very well cause some
adopters to hesitate before
looking for alternatives in Ubuntu.
Canonical is trying to improve this
situation by integrating small-
screen support into their API, in
the hopes that developers will
start adding support for Ubuntu
Touch long before the stable
release. Ultimately, you can't do
anything besides waiting for the
release before deciding whether
or not it's worth it.

Do you have any Android apps
you don't think you could live
without? Let me know in an email
(address in the last paragraph of
this article).

DOESN'T UBUNTU TOUCH

USE ANDROID?

Ubuntu Touch is based off
CyanogenMod 10.1 (jelly bean).
However, besides the device
support, and the system with
which Ubuntu is flashed/booted,
there isn't a lot left of the ROM.
Ubuntu itself is being run from a
chroot environment the moment
all device drivers are loaded from
the Android framework. The
reasoning for this, I imagine, is that
it enables wider support for
devices, and avoids the need to
write new drivers for every piece
of hardware. I don't see a lot of
potential downsides with this
method.

DOES UBUNTU TOUCH HAVE

A FUTURE?

I think it most definitely will
continue to be developed. If the
speed with which the developer
preview was ported to different
devices is any indicator, it may
grow very, very quickly. I doubt it
will replace Android, just as Web
OS, Windows Phone and iOS failed
to eliminate other mobile OSes. It
will probably carve out a market

share for itself, and be especially
interesting to businesses. The
reason for this is the fact that,
once enough phones meet the
requirements, Ubuntu Touch can
easily be used as a desktop (with
the correct docking tools). It will
probably appeal to those
companies who are currently
assigning each employee a work
phone, a work laptop, and/or a
work tablet. With Ubuntu Touch,
you could issue a phone and a
dock, and simply fill your offices
with docks, keyboards, mice and
monitors. How feasible this is
depends entirely on the actual
implementation of this desktop
feature in the final product.

CONCLUSION

There is little anyone can say for
certain. However, knowing FOSS
development, we'll be sure to see
rapid progress as we approach the
estimated late 2013/early 2014
release date for Ubuntu Touch
devices. The basic premise, and the
features Canonical is trying to
integrate, are both things I am
extremely interested in. If they can
pull it off, I will definitely be giving
the Ubuntu devices a fair chance.
The moment it becomes more

functional (and device support is a
little better), I'll be sure to give
installing it on my TF101 another
shot.

As always, I hope at least a few
readers have found this article
interesting. If you have an opinion
on Ubuntu Touch (or simply
agree/disagree with my opinions),
feel free to send me an email at
lswest34@gmail.com. Please put
“C&C” or “FCM” in the subject, so
that it doesn't get lost in my inbox.

Further Reading

http://www.ubuntu.com/devices/t
ablet (Tablet page)

http://www.ubuntu.com/devices/p
hone (Phone page)

https://wiki.ubuntu.com/Touch/De
vices (List of devices and their
current port progress)

COMMAND & CONQUER

mailto:lswest34@gmail.com
mailto:lswest34@gmail.com
mailto:lswest34@gmail.com
http://www.ubuntu.com/devices/tablet
http://www.ubuntu.com/devices/phone
https://wiki.ubuntu.com/Touch/Devices
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HHOOWW--TTOO
Written by Greg Walters PPrrooggrraammmmiinngg IInn PPyytthhoonn:: PPtt 4422

Let's assume that you have
decided to create a multimedia

center for your family room. You
have a dedicated computer for the
wonderful program called XBMC.
You've spent days ripping your
DVD movies and TV series onto the
computer. You have done the
research and named the files the
correct way. But let's say that one
of your favorite shows is "NCIS,"
and you have every episode that
you can get on DVD. You found a
place that provides the current
episodes as well. You want to find
out what the next episode is and
when it will be broadcast. Plus, you
want to create a list of all the TV
episodes that you have to impress
your friends.

This is the project we will be
starting this month. Our first task
is to dig through the folder
containing your TV shows,
grabbing the series name, and
each episode – including the name
and season number, and the
episode number. All this
information will go into a database
for easy storage.

According to XBMC, you should
name each of your tv episode files
like this:

Tv.Show.Name.SxxExx.Episode
name here if you
care.extension

So, let's use the very first
episode of NCIS as an example. The
filename for an AVI file would be:

NCIS.S01E01.Yankee White.avi

and the very latest episode
would be:

NCIS.S10E17.Prime Suspect.avi

If you have a show name that
has more than one word, it could
look like this:

Doctor.Who.2005.S07E04.The
Power of Three.mp4

The directory structure should
be as follows:

TVShows
2 Broke Girls

Season 1
Episode 1
Episode 2
...

Season 2

...
Doctor Who 2005

Season 1
...

Season 2
...

and so on. Now that we know what
we will be looking for and where it
will be, let's move on.

A very long time ago, we
created a program to make a
database of our MP3 files. That
was back in issue #35 I believe,
which was part number 9 of this
series. We used a routine called
WalkThePath to recursively dig
through all the folders from a
starting path, and pull out the
filenames that had a ".mp3"
extension. We will reuse most of
that routine and modify it for our
purposes. In this version, we will be
looking for video files that have
one of the following extensions:

.avi

.mkv

.m4v

.mp4

Which are very common
extensions for video files in the
media PC world.

Now we will get started with
the first part of our project. Create
a file called "tvfilesearch.py". Be
sure to save it when we are done
this month, because we will be
building on it next month.

Let's start with our imports:

import os
from os.path import join,
getsize, exists
import sys
import apsw
import re

As you can see, we are
importing the os, sys and apsw
libraries. We've used them all
before. We are also importing the
re library to support Regular
Expressions. We'll touch on that
quickly this time, but more in the
next article.

Now, let's do our last two
routines next (next page). All our
other code will go in between the
imports and these last two
routines.

This (next page, bottom right) is
our main worker routine. In it, we
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HOWTO - PROGRAMMING PYTHON Pt42
create a connection to the SQLite
database provided by apsw. Next
we create a cursor to interact with
it. Then we call the MakeDatabase
routine which will create the
database if it doesn't exist.

My TV files are located on two
hard drives. So I created a list to
hold the path names. If you have
only one location, you can change
the three lines to be as follows:

startfolder =
"/filepath/folder/"

WalkThePath(startfolder)

Next, we create our "standard"
if __name__ routine.

#============================
if __name__ == '__main__':

main()

Now all the dull stuff is done, so
we can move on the the meat and
potatoes of our project. We'll start
with the MakeDataBase routine
(middle right). Put it right after the
imports.

We discussed this routine
before when we dealt with the
MP3 scanner, so I'll just remind you
that, in this routine, we check to
see if the table exists, and if not,

we create it.

Now we'll create the
WalkThePath routine (right,
second from bottom).

When we enter the routine (as

we talked about way back when),
we give the filepath that we are
going to search through. We clear
the showname variable, which we
will use later, and open an error
log file. Then we let the routine do
its thing. We get back from the call
(os.walk) a 3-tuple (directory path,
directory names, filenames). The
directory path is a string which is
the path to the directory, directory
names is a list of the names of

subdirectories in the path, and the
filenames is a list of non-directory
names. We then parse through the
list of filenames, checking to see if
the filename ends with one of our

target extensions.

for file in [f for f in files
if f.endswith
(('.avi','mkv','mp4','m4v'))]
:

#=========================================
def main():

global connection
global cursor
# Create the connection and cursor.
connection = apsw.Connection("TvShows.db3")
cursor = connection.cursor()
MakeDataBase()

#=========================================
# Set your video media paths
#=========================================
startfolder = ["/extramedia/tv_files/","/media/freeagnt/tv_files_2/"]
for cntr in range(0,2):

WalkThePath(startfolder[cntr])
# Close the cursor and the database

cursor.close()
connection.close()
print("Finished")

#=========================================
def MakeDataBase():

# IF the table does not exist, this will create the table.
# Otherwise, this will be ignored due to the 'IF NOT EXISTS' clause
sql = 'CREATE TABLE IF NOT EXISTS TvShows (pkID INTEGER PRIMARY KEY, Series TEXT,

RootPath TEXT, Filename TEXT, Season TEXT, EPISODE TEXT);'
cursor.execute(sql)

#=========================================
def WalkThePath(filepath):

showname = ""
# Open the error log file
efile = open('errors.log',"w")
for root, dirs, files in

os.walk(filepath,topdown=True):
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Now, we split the filename into
the extension and the filename
(without the extension). Next, we
call the GetSeasonEpisode routine
to pull out the Season/Episode
information that is embedded in
the filename, assuming it is
correctly formatted.

OriginalFilename,ext =
os.path.splitext(file)

fl = file

isok,data =
GetSeasonEpisode(fl)

GetSeasonEpisode returns a
boolean and a list (in this case
"data") which holds the name of
the series, the season, and the
episode numbers. If a filename
doesn't have the correct format,
the "isok" boolean variable (top
right) will be false.

Next (middle right), we will
check to see if the file is in the
database. If so, we don't want to
duplicate it. We simply check for
the filename. We could go deeper
and make sure the path is the same
as well, but for this time, this is
enough.

If everything works as it should,
the response from the query

should only be a 1 or a 0. If it's a 0,
then it's not there, and we will
write the information to the
database. If it is, we just move
past. Notice the Try Except
commands above and below. If
something goes wrong, like some
character that the database
doesn't like, it will keep the

program from aborting. We will,
however, log the error so we can
check it out later on.

We are simply inserting a new
record into the database or writing
to the error file.

# Close the log

file
efile.close

# End of WalkThePath

Now, let's look at the
GetSeasonEpisode routine.

#============================
=============
def

if isok:
showname = data[0]
season = data[1]
episode = data[2]
print("Season {0} Episode {1}".format(season,episode))

else:
print("No Season/EPisode")
efile.writelines('---------------------------\n')
efile.writelines('{0} has no series/episode information\n'.format(file))
efile.writelines('---------------------------\n\n')

sqlquery = 'SELECT count(pkid) as rowcount from TvShows where Filename =
"%s";' % fl

try:
for x in cursor.execute(sqlquery):

rcntr = x[0]
if rcntr == 0: # It's not there, so add it

try:
sql = 'INSERT INTO TvShows (Series,RootPath,Filename,Season,Episode)

VALUES (?,?,?,?,?)'
cursor.execute(sql,(showname,root,fl,season,episode))

except:
print("Error")
efile.writelines('---------------------------\n')
efile.writelines('Error writing to database...\n')
efile.writelines('Filename = {0}\n'.format(file))
efile.writelines('---------------------------\n\n')

except:
print("Error")

print('Series - {0} File - {1}'.format(showname,file))
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HOWTO - PROGRAMMING PYTHON Pt42
GetSeasonEpisode(filename):

filename =
filename.upper()

resp =
re.search(r'(.*).S\d\dE\d\d(\
.*)', filename, re.M|re.I)

The re.search portion of the
code is part of the re library. It
uses a pattern string, and, in this
case, the filename that we want to
parse. The re.M|re.I are parameters
that say that we want to use a
multiline type search (re.M)
combined with an ignore-case
(re.I). As I said earlier, we'll deal
with the regular expressions more
next month, since our routine will
match only one type of
series|episode string. As for the
search pattern we are looking for:
".S", followed by two decimal
numbers, followed by an
uppercase "E", then two more
numbers, then a period. If our
filename looked like
"tvshow.S01E03.avi", this would
match. However, some people
encode their shows like this
"tvshow.s01e03.avi", or
"tvshow.103.avi", which makes it
harder to deal with. We'll modify
this routine next month to cover
the majority of the instances. The
"r'" allows for a raw string to be
used within the search.

Continuing on, the search
returns a match object that we can
look at. "resp" is a response that is
empty if there is no match, and, in
this case, two groups of returned
information. The first one will give
us the characters up to the match,
and the second including the
match. So, in the case above,
group(1) would be "tvshow", and
the second group would be
"tvshow.S01E03.". This is specified
by the parens in the search "(.*)"
and "(\.*)".

if resp:
showname =

resp.group(1)

We take the show name from
group number one. Then we get
the length of that so we can grab
the series and episode string with
a substring command.

shownamelength =
len(showname) + 1

se =
filename[shownamelength:shown
amelength+6]

season = se[1:3]
episode = se[4:6]

Next, we replace any periods in
the showname with a space – to be
more "Human Readable".

showname =
showname.replace("."," ")

We create a list to include the
show name, season and episode,
and return it along with the True
boolean to say things went well.

ret =
[showname,season,episode]

return True,ret

Otherwise, if we didn't find a
match, we create our list
containing no show name and two
"-1" numbers, and this gets
returned with a boolean False.

else:
ret = ["",-1,-1]
return False,ret

That's all the code. Now let's
see what the output would look
like. Assuming your file structures
are exactly like mine, some of the
output on the screen would look
like this...

Season 02 Episode 04
SELECT count(pkid) as
rowcount from TvShows where
Filename =
"InSecurity.S02E04.avi";
Series - INSECURITY File -
InSecurity.S02E04.avi
Season 01 Episode 08
SELECT count(pkid) as
rowcount from TvShows where
Filename =
"Prime.Suspect.US.S01E08.Unde
rwater.avi";
Series - PRIME SUSPECT US
File -

Prime.Suspect.US.S01E08.Under
water.avi

and so on. You can shorten the
output to keep the screen from
driving you crazy if you would like.
As we said earlier, each entry we
find gets put to the database.
Something like this:

pkID | Series | Root Path
| Filename
| Season | Episode

2526 | NCIS |
/extramedia/tv_files/NCIS/Sea
son
7|NCIS.S07E04.Good.Cop.Bad.Co
p.avi | 7 | 4

As always, the full code listing is
available on PasteBin.com at
http://pastebin.com/txmmagkL

Next time, we will deal with
more Season|Episode formats, and
do some other things to flesh out
our program.

See you soon.

Greg Walters is owner of RainyDay
Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.

http://www.thedesignatedgeek.net
http://pastebin.com/6iw5NQrW
http://pastebin.com/txmmagkL
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Have you ever been working in
a word processor and needed

to insert a formula into the text?
Perhaps you were writing a math
or scientific paper for college, or
even answering a question about
statistics. If you need to enter
anything beyond elementary math,
you will quickly run into formatting
issues. LibreOffice overcomes this
problem by providing us with the
Math or Formula module. You can
use the module independently to
create formulas, or use it directly
in the other modules of
LibreOffice. Today, we will learn
how to enter formulas in the Math
editor, and, in later articles, we will
learn how to use formulas in
Writer.

Open a new Math window by
clicking on the Formula button on
the LibreOffice Start Center, or
through the menus with File > New
> Formula.

THE FORMULA WINDOW

The formula window has three
pieces: the preview pane, the
formula editor, and the elements

window. The preview pane at the
top shows you your formula as it is
created. The formula editor at the
bottom is where you enter your
formula. The floating Elements
window provides you with
shortcuts to different formula
elements. Think of the elements as
building blocks for creating your
formula.

THREE WAYS TO ENTER

FORMULAS

There are three ways to enter

formulas into the formula editor:
through the Elements window,
through a context menu, or by
direct entry.

THE ELEMENTS WINDOW

The Elements window is divided
into two sections. The top section
is the category section, and the
lower section contains the
elements in that category. If you
select a category then click on one
of the elements in that category,
the program will enter the element

into the editor with <?> as
placeholders for the variables of
the element. The first placeholder
is highlighted. Use the F4 key to
move to the next element. Shift-F4
will move backwards through the
placeholders.

To get you familiar with the
Elements window, I will walk you
through the steps to write a
formula using the Elements
window. Starting with a new
formula window, select the
Relations category, then the
equals element. <?> = <?> appears
in the formula editor. The first <?>
is highlighted. Enter the letter “h”.
Press F4 to move to the other <?>.
Select the Functions category,
then the square root element. The
<?> is replaced with sqrt{<?>} and
the placeholder in the brackets is
highlighted. Select the
Unary/Binary category, then the
addition element. The program
inserts <?> + <?> into the square
root's brackets. Select the Formats
category, then the Superscript
Right element. <?>^{<?>} replaces
the highlighted placeholder. Enter
the letter “a” and press F4 to move
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to the next placeholder. Enter the
the number “2”. Press F4 to move
to the next placeholder. Select the
Superscript Right from the
Formats category. Enter the letter
“b” and press F4 to move to the
last placeholder. Enter the number
“2”. The final result will look like
this:

and the text in the formula editor
is:

h = sqrt{a^{2} + b^{2} }

THE CONTEXT MENU

The context menu (shown
below right) is much like the
Elements window. Right-click in
the formula editor, and you get a
menu of all the categories. Each
category has a submenu of the
elements. Click on the element to
insert it into the formula editor.
Follow the example above again,
but this time use the right-click
context menu to create the
formula. You should get the same
results.

DIRECT ENTRY

As you work with Math and
learn the elements, you can enter
the formulas directly in the
formula editor. By far, this is the
quickest way to enter a formula.
Now that you have created the
formula twice, using the Elements
window and context menu, see if
you can enter it directly into the
editor without using the element
tools. If you need help, just
reference the editor text shown
above.

SPECIAL CHARACTERS

You won't find everything you
need in the Elements window and
context menu. Many equations use
Greek characters and other
symbols. LibreOffice Math allows
you to enter special characters into
your equation. If you find you need

a special character not listed in the
special characters, you can even
add your own.

ADDING GREEK CHARACTERS

Through the menus Tools >
Catalog, you can access the Greek
letters through the character
subsets Greek and iGreek. Greek is
the letters in plain text and iGreek
is the letters in italics. Just select
the letter you want and click the
Insert button. When finished, click
the Close button.

For direct entry, type in %
followed by the Greek letter name.
For example, to get the Greek
letter pi, enter %pi. To get the
uppercase letter, make the name
uppercase, %PI. To make the
character italics, place a lowercase
“i” before the letter's name, %ipi.

OTHER SPECIAL

CHARACTERS

Other special characters are
found in Tools > Catalog under the
Special subset. Select the symbol
you need and click the Insert
button. As you use and learn the
names of the symbols, you can
enter them directly using the %
and then the name of the symbol.

NOTE: The lowercase “i” for italics
works with only the Greek letters.
We will discuss inserting italics for
other elements in the next How-
To.

ADDING SPECIAL

CHARACTERS

If the catalog does not have the
special character you need, you can
add it to the catalog. One such
character is the prime symbol.
Let's add it to our special subset.

Tools > Catalog and select the
Special symbol set. Click on the
Edit button. This bring up the Edit
Symbol dialog. For the font select
DejaVu Sans, and for the subset
select General Punctuation. The
symbol you want is Ux2023. For
the symbol name type in prime.
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Click the Add and OK buttons. The
prime symbol has now been added
to the Special symbols list. You can
use it by selecting it from the
catalog, or enter it directly by
typing %prime.

CONCLUSIONS

Math allows you to create
formulas you can insert into your
documents. You have three
methods for entering formulas
into the formula editor: through
the Elements window, through the
context menu, and by direct entry.
The Elements window and the
context menu help you to learn
how to enter the different
elements of a formula, but once
you know how to enter an
element, direct entry is the

quickest way to create a formula.

In the next LibreOffice How-To,
we will look at ways to format our
formulas so they look the way you
want them.
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If you're interested in genealogy,
but don't want all the “features”

found in the latest programs (such
as Gramps), perhaps Personal
Ancestral File, PAF, will be your
best bet. PAF is certainly great for
beginners – thanks to its simple
uncluttered interface, bullet-proof
data handling, and ability to export
seamlessly to just about any
serious genealogy program.

Why am I touting a Windows
program in a Ubuntu magazine?
Well, Gramps is just too feature
rich for many beginners or more
casual researchers. The myriad
features and the wealth of places
to record data seem to overwhelm
many would-be users. They
certainly overwhelm me – and I've
been researching family history
since the 90's. Then too, much of
the richness comes from add-on
subprograms that don't necessarily
update along with the main
program.

PAF is available at no cost from
the Family Search website thanks
to the generosity of The Church of
Jesus Christ of Latter-day Saints,

LDS. No, the Mormons won't try to
convert you or subvert your
research, it’s truly free. No strings
attached. PAF 5 will do almost
anything that a family history
researcher needs, and do it well.
Furthermore, PAF will not expose
any of your data on the Internet. It
runs strictly on your computer with
no Internet connection required.
But it’s available only for Windows,
so we first need to -

INSTALL WINE

As usual in Linux, there are
several ways to do this:
• Open your distribution's package
manager – Synaptic Package
Manager for Ubuntu and
derivatives – click Reload to update
the database, type “wine” in the
search box, choose and install the
default Wine meta-package. See
the note regarding 'ttf-
mscorefonts-installer'.
• To install the latest version of
wine directly from the author’s
site, open a browser and navigate
to http://www.winehq.org/ , click
'Download', select the right binary
for your distribution (Linux Mint

works well with the Ubuntu
binary), and follow the
instructions. Get and then install
the latest stable version.
• Open your distribution's Software
Manager, Software Center or
whatever they call it, search for
Wine, then choose and install the
Wine default meta-package. In my
experience, this choice often has
considerable difficulty with the
'ttf-mscorefonts-installer' – which
is part of Wine.

You may have difficulty
installing wine when it comes to
installing 'ttf-mscorefonts-
installer'. MS wants you to agree
with their license. This spawns a
child window, requesting your
response, that you may find hard
to see. Once you've agreed and
clicked OK, the installer will do its
job – go get a cuppa!

You'll want to review the
“installation and configuration
how-to” when done. Wine will
install a “Wine” entry on your
menu. Programs you've installed
may be found there or in an
“Other” menu entry.

As an aside, this latest version
should also allow Ancestral Quest
and the Windows version of the
Kindle reader to install.

INSTALL PAF 5.2

Open a browser and navigate to
http://www.familysearch.org/eng/
paf/ Provide any required
registration information – LDS
won't spam you – you're safe here.
Click to download the latest
version for your language – save
the file in your 'Downloads' folder.

Install the “official” way:
• Navigate to your 'Home >
Downloads' folder.
• Right-click
'PAF5EnglishSetup.exe'
• Select 'Open With Wine Windows
Program Loader' from the 'Open
With' option.
• Choose the installer's defaults
and PAF5 should install correctly.
Let the installer place a shortcut
on the Desktop because the link in
the Wine Menu might not work
right!
• You will probably want to un-

http://www.winehq.org/
http://www.familysearch.org/eng/paf/
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select the 'Use LDS data' block
unless you're a Mormon.

Install the other way:
• Open your 'Downloads' folder.
• Right-click an empty place and
select 'Open in Terminal'. If you
lack that option, open a terminal
and navigate to your 'Downloads'
folder.
• Type 'wine PAF5' and press [Tab].
(Upper- and lower-case are
important here.) The full filename
will fill-in for you. Press [Enter] and
you're on your way.
• Choose the installer's defaults
and PAF5 should install correctly.
Let the installer place a shortcut
on the Desktop because the link in
the Wine Menu might not work
right!
• You will probably want to un-
select the 'Use LDS data' block
unless you're a Mormon, that is.

WORKING WITH PAF

IF you're the patient sort,
reading the “User's Guide” file will
help you more than this brief note.
After installing PAF, the user guide
can be found by using Wine's
'Browse c: Drive' to navigate to
C:\Program Files\Family
Search\PAF5. The guide is named

“paf5.pdf”.

For the rest of us: Double-click
the icon on your desktop and an
empty PAF window will open, a
'Welcome' window will then open
briefly, followed by another giving
user choices. Your obvious choice
here is 'New'. Choosing 'New' will
open the 'New File' window –
where you should give the file a
meaningful name and choose
where to store it.

Give some thought to the
storage location. Maybe you have
an existing Home/Genealogy
folder, but it is, or will be, pretty
cluttered with other information.
Perhaps a better choice would be
Home/user-name/PAF
(z:\home\user-name\PAF in wine
terms) folder reserved for the data
file, backups, and a Media folder. I
wouldn't suggest using the Wine
c:\ drive because it is hard to find
except when Wine is active. The
New File dialog will allow you to
navigate back to your home folder
and create the PAF folder.

The window will transform into
a blank working screen with the
main 'Individual' tab selected. On
top of that, 'Preferences' will open.

• The first tab open will be where
you enter your preparer data. This
data will be available to the

program so that it can mark the
various reports it generates. Might
as well fill it in now.
• Select the 'General' tab and check
your choice of boxes. Some
suggested choices are selected in
the example.
• If your display is unclear select
the 'Fonts' tab. The fonts I've
selected are the ones used in the
various screenshots. This may be a
non-issue on your machine.
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• Select the 'Names' tab. I suggest
the selected choices.

• You can return to 'Preferences' at
any time by selecting
Tools>Preferences on the program
toolbar. Some data-entry screens
will also have this screen available.
• Click 'OK' to exit 'Preferences'.

PAF's working window will be
displayed with the main 'Individual'
tab selected.

Either right-click in the name
field or click the 'New Person' icon
on the program toolbar, and the
'Add New Individual' window will
open.

Enter the first person's name in
the order you selected in the
preferences dialog. A small
window will open asking you to
confirm that the program “knows”
the right surname – it denotes
surnames with / /. I generally add
them as I go. Be sure to select the
correct gender – in any program
it’s difficult to fix it later.

Add dates and places as
appropriate to this individual. Click
the small 'S' to the right to enter
your source for the event.

As you use the program and add
sources, they will be listed here.
You can select a listed source or
add a new one. Select 'New', enter
the source details then click

'Select'.

The 'Edit Source' window will
open; fill in the details for this
specific source.

Think of the top part of this
window as if it were a bibliographic
entry, and the bottom as the
specific citation. In the middle is a
button to add the repository
(library, web page ...) where you
actually found the source. The
bibliographic entry can be reused
(think of a book), while the citation
is very specific (think page
number). I've not been very
rigorous in this example. For a
source like that shown, quoting the
'Actual Text' in the space provided
would be a fine idea.



full circle magazine #71 18 contents ^

HOWTO - USE PERSONAL ANCESTRAL FILE IN WINE

At some point, click the
'Repository' button and fill in the
location where you found the cited
source.

It is accepted that you will have
a personal file where some of your
specific documents are located.
You should create a formal
repository for that.

The five icons to the right?
• The one that looks like a
notebook and pencil opens the
'Notes' window where you can add
information as you choose. A great
place to record residences the
person occupied over time - jobs,
education, research notes, to-do
lists ... If you begin a new line in
notes with the tilde '~' followed by
a space, that note becomes
private. You can control whether
that note is included in GED files or
printed in reports.
• The icon that looks like a book
allows you to examine all of the
sources cited for that individual.

• The icon looking like a mail
envelope allows you to enter
contact information for that
person.
• The camera icon allows you to link
multimedia to the person. My
preference here is to create a
multimedia folder in the same
place that the main PAF file is
located. The first picture here will
be the default shown on many
screens. Cropping and editing a
copy here will make the picture
more relevant and it won't mess up
the original. Multimedia does not
have to be a picture – an item could
be a scan of a birth certificate for
instance.
• 'Individual Sources' will open the
'Select Source' window allowing
you to add sourcing for the
individual rather than for an event.

Click 'Save' to enter the
person's data into the database
and return to the main window.

Select the 'Family' tab (shown
below). A family window will open
with data for the person you just
entered highlighted as the
'selected' person.

You'll note that the upper right
corner of the blue selection is
missing. That indicates that the
person has source data or notes.
Having multimedia files adds a
small square to the corner.

Click the space for spouse or
either parent, and the New Person
screen will open – you know how
to handle that. If multiple spouses
have been added, an 'Other

Marriages' block will appear above
the spouse block. Clicking the
arrow will open a screen allowing
you to exchange the spouses
(spice?). If the family you're mainly
interested in isn't the one
displayed by default, you can use
the 'Edit>Order Spouses' tool to
bring the focus to the spouse so
that you can select which one
appears.

Right-click an empty space in
the 'Children' block and you can
select 'Add Child' – you know how
to handle the screen that will
open. If you don't enter the
children in order, use the
'Edit>Order Children' tool to
arrange them in oldest to youngest
order.

Right-clicking the 'Marriage'
block, and then clicking 'Add', will
open the 'Edit Marriage' screen.

Dates, places, notes and
sources are entered in the way
you've done it already. Note there
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is a box for divorced. Adding a
spouse will also open the 'Edit
Marriage' screen. When there are
multiple spouses a double-headed
arrow will appear to the right of
the appropriate name.

At some time, you will come
across a GEDCOM file containing
information you'd like to add to
your data. Ideally it will
incorporate sourcing information.
BACK-UP your file, then use the
'File>Import...' tool to bring it in.
I'd suggest closing your working
file then creating a new file and
importing the GEDCOM into it. Do
this before you even think of
adding it to your main file. After
importing a GED into an existing
file a window will open offering
help in linking the imported data
into the existing database. Reading
it will help avoid really messing up
your hard work! Be especially
careful in merging information
contained in both files – it’s not at
all unusual to have people with
similar or even exactly the same
name in the same place at the
same time! In Onondaga County,
NY, there are apparently two
George Wellington Wilsons – both
born at roughly the same time!

Select the 'Pedigree' tab. PAF

will generate a five generation
pedigree (shown below) for the
person highlighted in the previous
tab.

The illustration shows the data
I've entered in my example
database. Note that hovering the
cursor on a person drops down a
list of more complete information.

I urge you to more fully explore
the functions available from the
main toolbar:
• You'll want to visit
'File>Check/Repair' if you have
problems especially after a merge
session.
• I'd back up using the file
'File>Backup...' tool after any
significant work has been done,
and especially before importing
anything into the database. PAF
will automatically back up the file
as often as you selected in
'Preferences'.
• 'File>Print Reports' will open the
'Reports and Charts' screen (shown
above) where you can choose to
print several different detailed
reports based on your data.

Your default printer should be
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available for your use under Wine.
You may also have the Linux PDF
printer installed on your system, it
too should work. PDF Printer
should be available from the
Software Manager or through the
Package Manager; I'd suggest
installing it.
• I recommend that you maintain a
notebook of 'Family Group Sheets'
for each family.
• “Printing” reports to PDF is a
great way to share information
through e-mail. Hint – PDF Printer
puts its output in a folder
'Home/PDF'.
• Once in a while, you should visit
the 'Lists' tab to generate a list of
unlinked individuals (people with
no family), duplicate individuals
(careful here), and 'Possible
Problems'.

The 'Tools' tab contains many
useful tools:
• After importing a GED file you
might use 'Match/Merge' to
merge-in duplicate people.
• If you've consistently misspelled
your hometown's name 'Global
Search and Replace' is the tool to
fix it.
• The old naming convention was
to use all caps for surnames.
'Change Names to Mixed Case' tool
will fix that.

• And, yes, you can generate the
basic files for a web page using the
'Create Web Page' tool.
• Can't remember whether old Sam
was your fourth cousin or third
cousin twice removed? The
'Relationship Calculator' will help
you remember.
• The 'Date Calculator' is a nifty
tool that will calculate a birth date
from a tombstone's 64 y 4 m 23 d
inscription. Works the other way
too.

GENEALOGY HINTS FOR

BEGINNERS:

Before you begin to record your
family history, here's some hints
gained from many researcher's
experience and mistakes.
• DO NOT start by trying to find
family data on the Internet.
• Begin by recording what you
know about yourself – your birth
date and place. How did you know
that? Gather copies of your birth
record if you don't have it already.
In the US, a birth certificate will
generally include only a minimum
of extracted data. Try to get a copy
of the actual courthouse journal
entries.
• Dates are usually entered in day-
month-year (08 Jun 2011) format

to avoid confusion. Enter as much
of the date as you know. Some
useful common abbreviations are –
cal, Calculated; bef, Before; aft,
After; ca, Circa; abt, About; est,
Estimated; bet, Between.
• Place names are generally
entered in small-to-large order -
parish, township or city; county;
state; country, e.g. Lysander
Township, Onondaga County, NY,
US of A. It is important that places
be entered as they existed when
the event took place. Knowing that
will help in locating primary
records. For example, the present
Oswego County, NY was formed
from Oneida and Onondaga
Counties in 1816. Hinmansville and
its records would have been in
Onondaga County in 1810, even
though it is in Oswego County now.
You won't find an 1810 census for
Oswego County.
• I guarantee that you will want to
revisit your source data at some
time in the future. Data on the
Internet had to come from
somewhere else. Cite the source of
your source. In that manner, you
have some assurance of finding the
data even if the site changes. It
may seem a tedious waste of
effort to find and record the
source information for your data,
but it’s not. Just do it.

• If you're married, record your
spouse's and children's data in the
same way. All this information is
recorded on a 'family group sheet'.
Your genealogy program will make
it for you.
• Now it’s time to record yourself
as a member of your parents’
family. Record your siblings too.
Again, secure copies of documents
that verify the data.
• Genealogy isn't just dates and
numbers. Try to flesh out your
knowledge with pictures,
recordings, letters, medical
information, precious objects and
interviews. Talk to your parents
about events that have special
meaning to them. Have them
identify people and places in
pictures.
• Working backward in time, record
your parents as members of your
grandparents’ families. You may
begin to find that documentation
is getting hard to find. Record
what you know and make a to-do
list for the unknowns. Try to find
pictures and get your
grandparents to talk about the
people and places in them.
• If you don't know a person's name
DO NOT enter unk or unknown –
that will bite you, guaranteed! I
type [–?–] and there's no question
that that’s a symbol – and not a
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name.
• Contact your cousins, aunts and
uncles. Find out about your family
history from “the horse’s mouth”
so to speak. One day, my cousin
and I looked at each other and
realized that we were 'the older
generation'!
• Start some sort of filing system
to keep track of the paper
documents you're gathering. Some
file by person, some by family.
Some use notebooks, some use
folders in a file; your choice. But do
something, or you'll find yourself
staring at a pile of half-
remembered papers! Develop a
system to preserve the names and
places you've identified in those
old pictures. I generally use long
filenames.
• It is helpful to keep a record of
places (books, web sites ...) you've
researched, what you searched for
and what you found. “Nothing” is a
perfectly valid and useful fact! This
practice will help prevent
searching again for the same item
in the same place. Of course, this
isn't strictly true in the case of
searching on the Internet since
URL's and content vary with time.
• At some point, hopefully after
you've recorded some data for
your grandparents or even great
grandparents, you will want to

seek further information on the
Internet. Learn to develop a
skeptical attitude toward what you
find – some “researchers” aren't at
all careful about what they record.
There are even known cases of
fraud. There's a lot of garbage and
copies of garbage out there. You
want to get back to hard evidence
– original records if they exist.
• As a newcomer to genealogy I'd
suggest that you visit
https://www.familysearch.org/lear
n/getting_started, and work
through some of the guides
provided. The Family Search site is
provided by The Church of Jesus
Christ of Latter-day Saints, the
Mormons. I understand that family
history is very important in their
religion. LDS have undertaken
some very large international
projects to digitize original records
– much of this work is available for
your research on the Family Search
website at no cost. They also have
a worldwide network of
FamilySearch Centers. At these
Centers you can view microfilm of
these original records and use
some for-fee sites at no cost on
their computers. Microfilm not
found at a Center can be rented
very reasonably from their main
library in Salt Lake City. No, I'm not
evangelizing here, it’s just that LDS

have generously provided these
services for our use at no cost and
with no strings attached.
• At some time, you will need to
visit
http://www.rootsweb.ancestry.co
m/ to consult and register for some
of their lists. You'll find a wealth of
background information on
RootsWeb. RootsWeb is hosted by
Ancestry, but has remained free
and independent of commercial
influence.
• Other resources include
www.worldgenweb.org, which will
link to www.usgenweb.org
www.canadagenweb.org and other
national sites. The information
you'll find here is organized
geographically and may contain
information you need.
• There is a tutorial and other
helpful guidance at
http://paftutorial.byu.edu/introfh.
htm
• There is a PAF5-USERS Group at
http://groups.yahoo.com/ with lots
of helpful members who don't
mind helping beginners.
• The Silicon Valley Computer
Genealogy Group has a very
helpful free download section and
an online store. They're at
http://www.svpafug.org/
• If you can afford it,
www.ancestry.com has, probably,

the most complete on-line digital
content. Remember the “Who do
You Think You Are?” TV series? You
can search for events, names or
places, find and view original and
secondary sources, and participate
in online training. Considering
Ancestry's vast content, the price
is reasonable.
• Google is your friend even for
genealogy!

I find it hard to rationalize this –
I use Linux Mint for my OS, but I'm
uncomfortable using Gramps – my
primary system is Ancestral Quest
(on Wine) – but I'd rather work
with PAF 5 than any of the others.

This brief note should get you
well started on the path to
building a good sound family
history database. Don't forget
those sources!

https://www.familysearch.org/learn/getting_started
http://www.rootsweb.ancestry.com/
http://www.worldgenweb.org
http://www.usgenweb.org
http://www.usgenweb.org
http://paftutorial.byu.edu/introfh.htm
http://groups.yahoo.com/
http://www.svpafug.org/
http://www.ancestry.com
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Textures and materials are very
crucial. Without them, for

example, what we have created so
far is a grey snowman, with a grey
nose, grey hands and a grey hat.
Not so realistic. So, materials and
textures is a way to add realism to
the look of our models with
images, plain colors, etc.

You must have a material to
apply a texture on it (by default
blender adds a material to your
objects in order to see their
surfaces).

So, for this month we will
introduce materials – leaving
textures for next month, as it is
impossible to fit them both in an
article.

But, before anything else, let’s
upgrade blender. A new release
(2.66a) is available at
http://www.blender.org/download
/get-blender/ with a bunch of new
features and over 250 bugfixes.

Let’s load the snowman blend
file that we created last month. It
has to look something like this in

object mode (shown below).

Notice the small icons at the
right of your 3D view window. The
fourth icon from the right
(highlighted) is the Materials tab.

Select the hat and press the
New button:

Name your material “Hat”. Your
material tab has to look something

like the one shown right.

As you can see, there are a lot
of things that we can tweak, but
we will introduce the very basics to
create a kind of realistic
environment (maybe, in a later
stage of this article-series, we can
focus on materials and textures
explaining all in detail, but, for
now, feel free to experiment with
those).

Blender gives us a preview
window where we can inspect the

http://www.blender.org/download/get-blender/
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color of our material. Also, on the
right, we can change the basic
object that we are previewing (this
doesn't affect our object at all, but
helps us to understand how the
color looks – for example on
spheres or boxes).

Under Diffuse, there is a white
strip. Press with your LMB (Left
Mouse Button) on it to change the
color. Select the color of your
choice from the color wheel, or
enter manually the values of Red,
Green and Blue below the wheel,
or you can use the color picker –
well known from other graphic
applications.

You can use the HSV button to
choose your color by Hue
Saturation and Value, or you can
use the Hexadecimal numbers that
are commonly used on web pages
to specify colors. I personally use
only the RGB values. The values
can vary from 0 to 1 indicating the
percentage of the color (0.2 = 20%
for example).

On the right of the wheel there
is a slider controlling the intensity
of the color. If you slide it all the
way down we have absolute black.
Also notice that values of Red,
Green and Blue are all changed to

0.

Under Specular, there is also a
white strip. From there we choose
the color of the reflection on
shining objects. For example
choose for diffuse: color Red =
0.015, Green = 0, Blue = 0.24, and
for specular: Red = 0.915, Green =
1, Blue = 0.

Also on the preview window,
change the basic object to monkey.

Looks like the image below?

NOTE: The monkey of blender is
actually a chimpanzee, called
Suzanne. This 3d mode, created by
Willem-Paul van Overbruggen, was
introduced to the blender

community as a test model for
materials, textures, lights, etc. The
Suzanne awards (something like
the Oscars awards) are held
annually for blender artists.
http://en.wikipedia.org/wiki/Suzan
ne_Award

Now, let’s go back to our
snowman. Reload the
snowman.blend file, select the
plane that we use as ground and
LMB on the material tab.

Press New to create a new
material and rename it from
“Material” to “Ground”.

Under Diffuse, press LMB on
the white strip and put the values
0.5 for Red and Blue and 0.8 for
Green. On the 3d view window, you
can see that the color of the
ground changes to a green looking
surface.

Select one button of the
snowman, and press the new
Button on the material tab. Name
it “Button”, and, under Diffuse,
color it red (by now you must know
the way to do that, but, in case you
don't, just put R = 1, G and B to 0):

Now, with your RMB, select
another button of the snowman.
Under the material tab, you can
see the New button that we used
earlier to create a new material.
Left of this there is an icon similar
to the “materials” one in blender.

Press it and select
Button from the list:

http://en.wikipedia.org/wiki/Suzanne_Award
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Nicholas lives and works in Greece.
He is working for a post-production
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several years. Three months ago he
migrated to Ubuntu because “it
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HOWTO - BLENDER Pt 4

The materials that we create
are stored for later use in the
blend file, and many different
objects can share the same
material.

Keeping that in mind, create
materials for the hands, the hat,
the nose, and the pipe. Also assign
the Button material to the other
buttons, or create a new material
for each button if you like.

For the hat I created a material
with a Halo behavior – just to make
a Saint snowman with two Halos!!!!
Very Saint!

You can experiment with the
other two kinds of materials
behavior: Wire and Volume.

For this month, I recommend
that you download and play a
game created in blender with the
blender game engine. Yo frankie!
http://www.yofrankie.org/

Also you can check out
blenderguru.com. A site dedicated
to blender, with a lot of tutorials
for beginner and advanced users,
created and hosted by Andrew
Price, a very talented blender
artist. Enjoy.
http://www.blenderguru.com

CCOODDEEWWOORRDD

Solutions are on the second last page.

Every number in the grid is 'code' for a letter of the alphabet.
Thus the number '2' may correspond to the letter 'L', for instance.
All - except the difficult codeword puzzles - come with a few
letters to start you off

Puzzles are copyright, and kindly provided by,
The Puzzle Club - www.thepuzzleclub.com

http://www.yofrankie.org/
http://www.blenderguru.com
http://www.thepuzzleclub.com
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In this instalment, we'll be
continuing our investigation of

Inkscape's text tools. Previously,
you learned how to create SVG
Text (compliant with the SVG 1.1
spec, and supported in many other
applications), and a couple of ways
to create Flowed Text (not
compatible with any official SVG
spec, so practically restricted to
use within Inkscape). Whichever
sort of text you use, when the Text
tool is selected, you are presented
with the same Tool Control Bar.
Last time, we looked at the left
half of this toolbar, where you can
select a font, size, style and
justification.

We used these controls to
choose the settings for an entire
block of text at a time, but
Inkscape also lets you apply most
of them to individual words or
characters within a text object. The
obvious use for this is to
emphasise particular words by
making them bold, italic, or bold
and italic, but you can also change
the font, size and color of parts of
your text, should you need to.

To begin with, you need to have
some text to modify. If you're
stuck for ideas as to what to type,
why not try the Lorem Ipsum
extension, which will generate
paragraphs of the classic nonsense
Latin text that typesetters
traditionally use as a placeholder.
Simply select the Extensions > Text
> Lorem Ipsum menu item, pick
some values for the three fields,
and click Apply. A Flowed Text
object will be created on a new
layer, with its flow box set to the
size of the page. You may want to
change the size of the flow box by
double-clicking on the text and
then moving the small diamond
handle at the bottom right, or you
could just make it flow into a new
object using the Text > Flow into
Frame menu that we looked at last
time.

With the Text tool selected,
click in the flowed text at the point
that you would like to place the
text editing cursor (from now on,
I'll use the term caret to

differentiate it from the mouse
cursor or cursor keys on the
keyboard). Alternatively, if the
Select tool is active, you can just
double click in the flowed text to
both position the caret and switch
to the Text tool in one fell swoop.

With the caret happily flashing
in the middle of your text, you
should be able to move it around
using the cursor keys, just as you
would in a word processor.
Pressing the Home and End keys
will jump the caret to the start or
end of the current line,

respectively, and holding down the
Shift key whilst performing any of
these movements will select the
appropriate section of text. The
mouse isn't without its uses either:
click to immediately position the
caret, or click and drag to select a
contiguous section of the text.
Double-click to select a word,
triple-click to select a whole line.

With a portion of the text
selected, it's time to play with the
style. Start by setting the fill to a
different color, or perhaps adding
a stroke. You can set the stroke-
width and join-type using the Fill
and Stroke dialog, but adding
markers will have no effect. Other
parts of the dialog affect the text
in different ways: you can set an
alpha level on the fill or stroke to
give it some transparency, but
changing the opacity setting has
no effect. If you try to use blur,
gradients or patterns, you'll find
the whole text object is affected,
rather than just the selected
section. Setting a dash style on the
stroke will also affect the whole
text object, though you won't
notice it on any words that don't
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have a stroke applied.

On the text control bar, you can
change the font for the selection,
alter its size, or use the bold and
italic buttons. The justification
buttons work for only the whole
text object, not individual
selections. This does, however,
mean that, if you want to left-
justify one paragraph and right-
justify the next, you'll have to split
them into separate text objects.
Nevertheless, by playing with
fonts, fills, strokes and more, you
can easily create some truly awful
text designs.

Now that you've got the hang
of positioning the caret and
selecting parts of the text, it's time

to investigate the less frequently
used icons and controls that
remain on the rest of the bar.

The first of these you may
recognise as Superscript and
Subscript. Although you can apply
them to an entire text object, they
work best on a selection of just a
few characters at a time. They have
the effect of reducing the font size
for the selection, and adjusting the
text's baseline up or down. The
size can subsequently be modified
using the toolbar, but adjusting the
position isn't so straightforward,
so although these buttons are
useful for simple super- and sub-
scripts such as chemical formulae,
they're not very useful if you want
to finely position your text.

Fine positioning is precisely
what the next six controls are all
about. The first three work on both
SVG Text and Flowed Text,
whereas the last three are disabled
for Flowed Text objects. The
former all deal with the general
spacing of your text, whereas the
latter allow fine control over
individual characters.

The first of the spacing controls
affects the spacing between lines
in a paragraph of text. The value in
here is multiplied by the font size
in order to produce the final
spacing. You can reduce this as low
as 0, in which case all the lines will
be on top of each other, but it
doesn't allow negative values so
you can't use it as a way to make
your paragraphs run from bottom
to top. Typically it's set to 1.25 for
normal paragraphs, though you
may wish to adjust it for a looser or
tighter design. This image shows
three paragraphs of our Lorem
Ipsum text, set to 0.75, 1.25 and
2.0 respectively.

The next two controls are used
to set the standard spacing
between individual letters, and the
spacing between words. The
tooltips claim that both these

values are in pixels, but, in my
experience, typing a value directly
into these – even if your document
is set to use pixels as the default
units – results in the value being
converted to something different.
In practice, it's not too great a
problem as it's rare to need
specific values in these fields.
More usually you will adjust them
up and down to make your text a
little tighter or looser. These fields
will allow you to enter negative
values, if you really do want your
text to run backwards!

The next control is used to
adjust horizontal kerning on SVG
Text. Kerning is the term used to
describe the spacing between two
individual characters. By adjusting
the kerning, you can arrange for
characters to slot together a little
more neatly, giving a more
pleasing look to text, with fewer
blank areas that can form visual
“rivers” of white on a page. Using
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this field is as simple as placing the
caret between the pair of letters
that you wish to kern, and then
entering a value to adjust the
spacing. Negative values are most
commonly used, to encourage the
second character to tuck-in to the
white space within the shape of
the first, but you can also use a
positive value to force a pair of
characters further apart. This
image shows the effect on a few
pairs of characters with no kerning,
and then with a negative value.

After the Horizontal Kerning
control, there's a similar field for
adjusting the vertical position of
your characters. If you simply
position the caret, then it shifts
the text from that point to the end
of the line up or down.
Alternatively you can select
specific characters or words to
limit its effects – although, if your
selection spans more than one
line, the behaviour can be a little
unexpected. Negative values in
this field will move your text
upwards, positive numbers will
move it downwards. Combined

with changing the font size, this
can give you more fine-grained
control than you get from using
the Superscript and Subscript
buttons.

The last of this group of
controls lets you rotate individual
characters, with the value being a
figure in degrees. Positive numbers
rotate clockwise, negative
numbers counter-clockwise.
Placing the caret will cause it to
rotate just the following character.
Selecting some text will rotate the
individual characters of the
selection, not the whole selection
as one. It's not possible to select
the rotation centre, but using the
Horizontal Kerning and Vertical
Shift controls can allow you to
compensate for this if you need to.

In practice, the Horizontal
Kerning, Vertical Shift and
Character Rotation controls are
often best adjusted using keyboard
shortcuts. Holding ALT while using
the cursor keys will adjust the
kerning and vertical shift, whilst
ALT-] and ALT-[ can be used for
character rotation. The Text >
Remove Manual Kerns menu entry
will remove all the Horizontal
Kerning, Vertical Shift and
Character Rotation adjustments

for the whole text object, but
won't remove any changes to the
line, letter or word spacing
controls.

The final buttons on the toolbar
let you switch between creating
horizontal and vertical text. In the
latter case, the individual
characters are the right way up,
but the words run vertically down
the page – as opposed to simply
rotating the text object, in which
case the characters are also
rotated.

There's one big elephant in the
room which can't go unmentioned
when discussing text and SVG files:
SVG fonts. The SVG specification
includes a font format where the
individual glyphs are defined using
standard SVG objects. In theory,
this should allow fonts to be
created that contain colour and
animations, and that can be
dynamically changed by using
standard Javascript code in a web
browser – all while still presenting
understandable text content to
search engines.

Although Inkscape contains a
dedicated interface for creating
SVG fonts, via the Text > SVG Font
Editor menu, there are a couple of
reasons why it's probably not

worth using. The first is that the
Firefox developers have
specifically rejected the idea of
supporting SVG fonts, due to their
lack of some layout and
internationalisation features that
are available in other font formats.
Their concerns are certainly valid
for a general purpose font format,
but I think that misses some of the
advantages that SVG fonts can
offer when used in an SVG image,
and which no other format can.

An even bigger reason not to
use SVG fonts, ironically, is
Inkscape itself. Although it has an
interface to help create them, it
has no mechanism to actually use
them once they've been created.
The Font Editor, therefore, is
useful only if you're creating SVG
fonts as an interim step towards
generating a TrueType or
Postscript font using an
application such as FontForge.

http://www.peppertop.com/
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GUIDELINES

The single rule for an article is
that it must somehow be

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.

• For advice, please refer to the
Official Full Circle Style Guide:
http://url.fullcirclemagazine.org/7
5d471

• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

document.

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

• Do not use tables or any type of
bold or italic formatting.

If you are writing a review,
please follow these guidelines :

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS

If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

• title of the game
• who makes the game
• is it free, or a paid download?
• where to get it from (give download/homepage URL)
• is it Linux native, or did you use Wine?
• your marks out of five
• a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

• make and model of the hardware
• what category would you put this hardware into?
• any glitches that you may have had while using the hardware?
• easy to get the hardware working in Linux?
• did you have to use Windows drivers?
• marks out of five
• a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.

http://url.fullcirclemagazine.org/75d471
mailto:articles@fullcirclemagazine.org
mailto:ronnie@fullcirclemagazine.org
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AASSKK TTHHEE NNEEWW GGUUYY
Written by Copil Yáňez

Hi, everyone! Welcome back to
Ask the New Guy!

If you have a simple question,
and want an answer that doesn’t
require you to enter your
superuser password, contact me at
copil.yanez@gmail.com.

Today’s question is:

Q: Ubuntu seems pretty mature.
Most things just work. Is there
anything left to be excited
about?

A: Well la-dee-da, you poor thing,
sitting over there bored out of
your superior mind. What, your
pygmy giraffes, and your heated
toilet seats, and your shoes that
are shaped like human feet (and
made from ACTUAL human feet)
not exciting enough for you?
Maybe if Mark Shuttleworth
included a free trip to the
International Space Station with
every install, you’d be less fatigued
by life?

I know how it is. If you’re like
me, you probably approached the

idea of a new OS like a first level
mage on your inaugural dungeon
campaign, exploring dark corners,
discovering treasure, gaining XP
(experience points), and leveling
up as you became more confident
in your abilities.

Eventually, though, you’re
sitting in a tavern, drinking mead
from the hollowed out skull of a
lowland Orc, and huffing drunkenly
as some new explorer stops in for
directions to a nearby dragon’s lair.

“Lookat thish guyoverhere,”

you mumble. “Probablyneverbeen
attackedbyaThroat Leach or

shmelledthe insides ofa deadIce

Lizard. Thinkyou can make itout

here?Idon’t think sho.”Eventually
someone calls you a cab.

My point is, sometimes it’s hard
to sustain that level of excitement,
especially when things are going
right. If you’re trying to figure out
how to get your laptop to see your
wireless router, seeking help from
a forum of fellow enthusiasts can
be fun and social. But if everything
works almost perfectly out of the

box, well, that’s exciting, too, but
not in the same way. And it means
the community, a great source of
camaraderie and entertainment,
gets bypassed by some new users.

Becoming a power user brings
its own excitement, of course, and
means you’re likely to encounter
and overcome bigger challenges as
you go. But this is Ask-the-New-
Guy, not Ask-A-Guy-Who-Knows-
What-The-Hell-He’s-Talking-About.
So what do average Joes like me
have to look forward to? What’s
exciting about Ubuntu other than
the fact that it just works?

Plenty!

In many ways, new and casual
users are the ones who have the
most to look forward to over the
next few years. Not only does
Ubuntu get better with each
release, the project is expanding
into some really exciting areas.

Let’s take a look at what’s on
the Ubuntu horizon.

GAMING

For the longest time, the single
biggest lament for many users who
didn’t want to make the switch to
Ubuntu was that there weren’t
enough games for it. This was
never really true, of course, there
have always been decent titles for
Linux, and the Ubuntu Software
Center made it criminally easy to
download the best ones.

But Steam, a popular digital
distribution platform with a deep
inventory of gaming titles, was
recently released for Linux and is
available from the Software
Center. I believe this is a game-
changer (pun totally intended
exactly two seconds after I realized
I had unintentionally made it). By

mailto:copil.yanez@gmail.com
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downloading the Steam software,
you can browse, download, and
buy the ever-growing list of games
that work on Linux – including
Counter-Strike and Runner2. And
this is just the beginning. Valve,
the maker of Steam, has promised
to release Left 4 Dead 2 and other
long-awaited titles in the next few
months.

Soon, you too will feel the
horror as Boomer, a bloated
zombie with infectious bile,
stumbles into your room looking
for night-night cuddles.

Some people might argue that
this is just one more company
looking to make money off Linux
users with no real love for its
ideals. But even putting aside
Valve’s past support for the Linux
community, that’s just the cynical,
eightieth-level mage in them
talking. I believe this will
encourage other developers to
port their popular free titles over
to Linux to engage a whole new
community of players.

Gaming isn’t going away and
neither is Linux. This is a good
marriage, more Julie Andrews and
Blake Edwards than Kim
Kardashian and Kris Humphries.

UBUNTU ON TABLETS

The biggest surprise at
Ubuntu’s recent unveiling of its
tablet OS was not that it had one,
but that the one it exhibited
seemed so polished and close to
being ready for prime time. Early
preview versions of heavy-use
software like this usually include
several blank screens, lots of
freezing, and a couple error
messages that say “And then a
miracle happens here.” Sure, there
will be growing pains as Ubuntu
moves from a developer version to
the end user install, but there’s a
lot to like here. Take a look for

yourself:
http://youtu.be/h384z7Ph0gU.

Be warned, the video involves
some of Mark Shuttleworth’s chest
hair, a 70’s-era peace sign belt
buckle, and a weird self-help vibe
that may be disturbing to former
cult members and recovering
hippies. Mark, talk faster! By. The.
Time. . .You. . . .Get. . . . .To. . . .The. .
. . . . . . Next. . . .. . .Word. . . . .I. . . . . .
.. . forget. . . . . what. . .. . . . . . I’m. . . .
. . . . . . . .watching.

Tablet and phone devices, in my
very unhumble opinion, are the
future of computing. Most of us
don’t need a Cray Titan to do all

that web browsing and memo
writing we do. (And seriously, we
could probably knock out the
memo writing altogether – who are
you writing all those memos to?). A
decent tablet with a good
keyboard and a fast Internet
connection will handle something
like 99% of our needs. It’s like
driving to work. Our average
commute is something like 32
miles round trip, so we don’t need
8-mile-per-gallon Ferraris when
Elon Musk’s Tesla will do it in
carbon-neutral style.

Holy Steaks! The most glorious
fantasy just occurred to me! What
if Elon Musk got into the Linux
game, and suddenly you had two
super-rich brainiacs competing
with each other to come up with
software indistinguishable from
magic?! It’d be like two Bond
Villains battling at the command
line! Can self-aware dishwashers,
and nanobots that turn human fat
into gold, be far behind? The
answer is no. No, they can’t.

UBUNTU TV

If Matthew’s death in the
Season 3 finale of Downton Abbey
was ruined by someone you follow

ASK THE NEW GUY

http://www.youtube.com/user/movies
http://www.hulu.com/labs/hulu-desktop-linux
http://www.canistream.it
http://youtu.be/h384z7Ph0gU
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on Twitter, then Ubuntu TV was
built for the way you watch TV, as
an interactive experience with a
community component. If
Mathew’s death was ruined by me
at the start of this paragraph, then
you need to catch up on your
recordings more often. C’mon,
TiVo is not a license to keep the
FireFly series finale in stasis in the
unhinged belief that the series
might still be picked up for another
season. Time-shifting is a privilege,
not a right, people!

Imagine you’re watching your
favorite episode of So You Think
You Can Dance? and a commercial
comes on for some kind of hybrid
breakfast cereal/pain reliever.
Instead of watching a cartoon
spinal disk sing about how
Ibuprophen-O’s are
contraindicated with milk, you
switch over to YouTube and call up
clips of Mary Murphy screaming
about the Hot Tamale Train! See?
The future is awesome!

If that doesn’t excite you, then
think about Ubuntu TV giving you
the functionality of a DVR coupled
with integrated social media and
access to all your media files. It’s
not so much a revolution as an
evolution of the smart TVs already

on the market mated with your
favorite operating system. Yes, it’s
quite possible that Canonical’s
master plan is to combine all
digital products and make them
operable from the most
comfortable seat in your house. If
you see them, buy Ikea –
remember, I told you so.

Check out this video
http://youtu.be/jq_WaOLjdyQ
which champions the idea that
DVRs don’t need to be separate
boxes, the functionality can be
built directly into the TV. Plus,
apparently creepy giant bunnies
figure prominently in our future.

UBUNTU ON PHONES

For my money, Ubuntu’s phone
OS has the potential to be the
most disruptive. The first
smartphone I owned completely
changed the way I interacted with
the Internet and the services I
found there. Having my favorite OS
on my phone, with all the
philosophical and practical changes
it brings with it, could have a
similar effect, at least on me.

The phone OS seems to have all
the features you’ve come to expect
from a smartphone. The things
that make it Ubuntu are tweaks
familiar from the desktop OS – like
lens-based search options and
customizable side panes that give
you access to frequently-used
programs and apps.

That apps ecosystem, in my
opinion, is what makes this OS a
game-changer. All the most
popular paid apps will likely make
their way over relatively quickly
because mortgages on Finnish
S&M dungeons don’t come cheap
(and don’t tell me you didn’t know
that’s exactly what Rovio was
doing with all that avian loot
they’ve been raking in). The more
interesting apps, however, are
merely gleams in a Linux
developer’s eye right now. I can’t
wait to see what Linux enthusiasts
bring to the phone world. When
SETI-Phone-Home becomes the
most popular app on the Ubuntu
phone, and we discover alien life
shortly thereafter, I want to be
named ambassador to Kepler 22b. I
will finally be able to say Klaatu
Barada Nikto unironically.

And, of course, the Ubuntu
philosophy of doing more with less
will also be ported to the smaller
screen. If you’ve ever run a
perfectly stable and useful Ubuntu
install on a machine others had
given up for dead, you’ll probably
appreciate having all the modern
conveniences of a powerful
smartphone running on a handset
a few generations old.

ASK THE NEW GUY

http://youtu.be/jq_WaOLjdyQ
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Copil is an Aztec name that roughly
translates to “you need my heart for
what again?” His love of women’s
shoes is chronicled at
yaconfidential.blogspot.com. You
can also watch him embarrass
himself on Twitter (@copil).

One of the really interesting
things about the phone OS is that,
for many people, this may be their
first point of contact for Ubuntu.
Once these new users discover
that the powerful, stable and
secure OS they’re using on their
phones is available also for their
desktops (and tablets and TVs), the
time of massive Ubuntu take-up
could be upon us.

Check out this video for more
Mark Shuttleworth chest hair:
http://youtu.be/cpWHJDLsqTU.

There’s also a project to put
Ubuntu on Android handsets and
make your phone a full-fledged
desktop by adding a full-sized
keyboard and monitor. I’m not
entirely clear on how the Ubuntu
phone OS overlaps with Ubuntu for
Android, or if that docking
functionality is part of the former.
But the idea of having one device
that works like a Transformer,
without any Michael Bay quick-cuts
to make me dizzy, is pretty
appealing.

CONCLUSION

The operative word for all these
OSs seems to be convergence. Any

cloud-based files and services
should be available across all
devices along with apps,
bookmarks and settings. And
familiar functions, like side panes
and drawers, should work similarly
on all screens.

What stands in the way of this
seamless Ubuntopia? Not the
software, certainly, since its
greatest strength is that it can
become whatever its users need it
to be. Even if the first versions of
each OS are mere shadows of their
mature potential, the energetic
give-and-take between Canonical
and the community will produce, as
it has so far, a decent compromise
between competing interests.

More likely, the real challenges
will come from hardware
manufacturers and existing service
providers who have a vested
interest in keeping existing
revenue streams in place (*cough*
wireless carriers *cough*).

The idea of opening the world
of phones, tablets and TVs to
neckbeards like me must just scare
the hell out of them. And that may
be the most exciting thing of all.

I know, I know, this is all a little
too fangirl for some of you. And
forget about Ubuntu hipsters, the
ones who talk about seeing
Ubuntu Warty Warthog doing open
mic nights at smoky Dublin pubs

back in the late 90’s. They’re not
going to be happy with this new
world where Ubuntu is as popular
as a Happy Meal (albeit much
healthier).

But the rest of us are likely to
enjoy new campaigns and
treasures as we slay dragons and
fight orcs in the Sauronic pursuit of
one OS to rule them all!

Good luck and happy
Ubuntuing!

ASK THE NEW GUY

http://yaconfidential.blogspot.com
http://youtu.be/cpWHJDLsqTU
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LLIINNUUXX LLAABB
Written by Charles McColm CCrruunncchhbbaanngg 1111 oonn aa DDeellll NNeettbbooookk

Several years ago, netbooks
were all the rage. I got my Dell

Inspiron Mini 10 (1012) at the
height of the netbook boom. For
two days I tried to use the
Windows 7 Starter Edition that
came with the netbook, but, after
removing all the junkware and
making a backup to an external
DVD burner, I still found the
netbook extremely slow. I gave
Windows a shot, it didn’t work out,
so I tried Ubuntu 10.04 from USB,
and the experience was magical.
Not only was Ubuntu 10.04
significantly faster, it came with
software I actually use. It was an
easy decision to erase Windows 7
and install Ubuntu.

I already had a notebook, so I
found myself not really using the
netbook. The small keyboard made
it somewhat difficult to type (long
fingers), and looking down isn’t
great for the neck. So I decided to
put the netbook to another use: it
became our family media center
after I added a remote control,
receiver, a couple of drives
attached via USB and XBMC
(formerly known as XBox Media

Center). It served that purpose for
a couple of years until I recently
replaced it with a desktop
machine. As much as I don’t like
craning my neck down to look at
the netbook, I’d been missing it at
the local Ubuntu hour meetings I
hold each month. My notebook is a
bit big for the cramped desk space
where we have the meetings (the
desk is usually covered with food).

Initially I tried Ubuntu 12.10 on
the netbook. Ubuntu ran on it, but
just barely. Performance was as
bad as, if not worse than, Windows
7 Starter Edition. I could have tried

Xubuntu or Lubuntu, both of which
run lighter than Ubuntu 12.10, but
a friend suggested I give
Crunchbang a try.

Crunchbang is Debian-based so
it shares some of the roots of
Ubuntu. Installing it to USB key
wasn’t as simple as other Ubuntu-
based distributions I’ve installed.
Normally, I use the usb-creator-gtk
application to install distributions
to a USB key, but Crunchbang kept
failing at the bootloader install
stage. I ended up unmounting the
USB key, running mkfs.vfat to
format the key, pulling it out and

installing using unetbootin. The
Inspiron Mini 10 uses a 64-bit Atom
processor so I installed the 64-bit
version of Crunchbang.

Once I figured out how to get
Crunchbang to the USB key, the
rest of the installation was very
similar to a graphical Ubuntu
install. Crunchbang uses the
Openbox window manager, so it’s
very lightweight. The initial
installation installs a handful of
desktop programs: Abiword,
Gnumeric, Gimp, VLC, XFBurn,
gFTP, Transmission and XChat are
among the more common
programs.

To keep things lean and mean,
Crunchbang doesn’t include
LibreOffice, but installing
LibreOffice is one of the options of
the firstboot program that loads in
a terminal when Crunchbang boots
for the first time. The firstboot
program asks if you want to
update the system, install
development packages, install
OpenSSH server, install a LAMP
(Linux Apache MySQL PHP) stack,
and install LibreOffice. Though it
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seems very developer-oriented, I
still like Crunchbang for the speed.

One of the Openbox claims is
that it’s infinitely configurable.
This does appear to be true, but
configuration isn’t quite as easy as
the days when Gnome 2 was
actively developed. Part of the
Openbox configuration can be
found in Settings > Openbox > GUI
Config Tool the other part in
Settings > User Interface Settings.
If you want to set the background
you need to use a third menu
option Settings > Choose
Wallpaper, and, if you want your
own wallpaper, you’ll need to click
the Preferences button in
Nitrogen’s (the wallpaper
program) UI to add the path to the
wallpapers you want to add. I
suppose this could be following
the UNIX philosophy – one tool
doing one thing really well, but a
single tool to do all three activities
would be nice for new Linux users.
I found Nitrogen to be buggy; it
seemed to forget the path added
the next time I launched it. The
path remained in the preferences,
but the images didn’t show in the
Nitrogen wallpaper selection.
Looking through the various
Settings, you’ll see there are a
large number of configuration

options, almost all of which require
knowing the format of some
configuration file. While the
configuration files are well
documented (and somewhat
obvious), it might be a bit much for
someone new to Linux.

Many of the hot keys that work
in Gnome 2, such as Ctrl+Alt+arrow
to switch workspaces, work in the
Openbox window manager. When
Crunchbang first loads, it also
loads a Conky file that shows some
common hotkeys to do things like
launch VLC, control volume, open
the Geany text editor, or launch
the run dialog. The super key
(Windows key) based programs are
generally commonly used

programs like the web browser, a
terminal, VLC, and text editor, in
addition to Logout and a couple of
menus.

From the perspective of
someone who doesn’t mind editing
a .config file, I really like
Crunchbang. Crunchbang is fast,
the super hotkeys make doing the
most common tasks easy, it’s
based on Debian, and everything
worked out of the box for me after
the install (including the wireless).

I’m not quite sure Crunchbang
will appeal to everyone, but, if you
don’t mind doing a bit of editing,
and love your system fast,
Crunchbang might just be for you.

P.S. if you like conky, the .conkyrc
I’m using can be found here:
http://charlesmccolm.com/2011/0
7/10/conky-modded-for-my-
notebook/

Charles is a step-father, husband,
and Linux fan, who hosts a not-for-
profit computer refurbishing
project. When not breaking
hardware/servers, he maintains a
blog at:
http://www.charlesmccolm.com/

http://www.charlesmccolm.com/
http://www.cdrinfo.com
http://www.cdrinfo.com/
http://www.btc.com.tw/
http://www.lg.com/
http://global.m.aopen.com/
http://charlesmccolm.com/2011/07/10/conky-modded-for-my-notebook/
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I stumbled upon the free
software world entirely by

accident. It was around 1999. I was
living with roommates and one of
them started a software
development course at his college.
I had Windows 98 installed on my
PC, and an analogue TV Capture
card that refused to work at full-
screen, even with all drivers
updated and reinstalled!

One day, I saw my roommate
playing around with a brand new
system on his computer: Red Hat
Linux. He used the command line a
lot, typing in a black-and-green
window – but still, I was
mesmerized. It seemed very easy
to use it, and he claimed it all
worked out of the box: no drivers
necessary. I asked if I could try it
on my own PC. He then revealed to
me it is free and no license key is
needed – that last bit made the
sale – no more tinkering endlessly
just to get my PC to work without
crashing every 5-10 minutes....

He burned me a copy of the CD.
Those were the 14.4 Kbps dial-up
modem days, so downloading

another copy would have delayed
me another day or two. I installed
it alongside my Windows 98, and
tried to see if everything worked.
And it did. Well, except my modem,
which was a Winmodem. But that
was easily fixed after searching the
Internet, using AltaVista Search in
the pre-Google days.

I started my
journey with
computers at the
age of 13, back in
the mid 80s, with
a Commodore
64. I used it
mostly for
gaming, of course,
but I even tried to
program a bit of BASIC
with it. I then moved to the
PC world using DOS 1.0 and all
through Window 3.1, Windows 95 (I
even touched Windows Millennium
Edition for a bit!), so I was no
stranger to the command line. I
always liked to see how things
worked under the hood, so I felt
right at home with my new Linux-
based machine. After two weeks –
during which I made sure all I

needed works, even my TV Capture
card worked better in Linux – I
backed up my files, formatted my
entire hard drive, and made the
move to the Free Software world –
and never looked back!

The first Ubuntu I installed was
version 5.04, back in 2005.

I read up a lot about
it in the Linux

news sites, and I
grew tired of
KDE at the
time and
wanted to try
something

new. I stuck
with Ubuntu

since then. I tried
LiveCD versions of

Fedora now and then,
but none of them were as usable
and stable as Ubuntu. I also liked
the fact that all new applications
come out with Ubuntu clients first
(eg, Steam by Valve), and the way
it's set up out of the box: the most
popular applications in each
category, and the fact the primary
user has to use the “sudo”
command and is not allowed to log

in as the root user by default. I
think this strategy saves a lot of
grief from inexperienced users.
Another thing I love about Ubuntu,
although controversial, is the Unity
interface. It takes some time to get
used to, especially for experienced
Linux users, but once you get used
to it, it is a cinch to use and
prevents clutter on the desktop.
From my experience, it is easier for
computer illiterate people to
understand, once you spend a few
minutes to explain the basic use.
They are so used to working with
badly designed User Interfaces, it
takes them a few minutes to
understand how Ubuntu / Unity is
simpler...

Written by Amichai Rotman

Amichai has been a computer
solutions provider for the last 13
years. He specializes in FOSS
solutions in his home town. You can
ask him anything Ubuntu/Linux by
emaiing: support@penguincsc.co.il.

mailto:support@penguincsc.co.il
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As I’m punching this out on my
old but trusty HP Pavilion

DM1, I’m somehow overpowered
by a sense of nostalgia, and …
irony.

I remember getting into
computers years ago, starting out
on machines like these, back in the
days when they were home-built
beige boxes, using a predecessor
(or should I say forefather) of the
operating system that is running
today. The last couple of years I
have swayed from that path of
using a ‘Redmond Based’ operating
system on my primary machines in
favor of the one created in
Cupertino. The last year or so, I
have even moved away from that
one, to start using ‘the penguin’
full time. For those of you baffled
by my ramblings, I’m a slider. I
move from operating system to
operating system, and use the one
that works for me. From Android
to IOS, from Windows to OSX to
Linux … and today .. back to
Windows again. The new Windows
8 Metro interface was not
something that stalked in quietly
in the night. The press had seen

this one coming, and had been
tooting their horns on how
“different” it was from Windows 7.
The Redmond company had had
rough times. The ‘Vista disaster’
had left its mark, and, even though
Windows 7 was a decent project,
the flame of innovation was lost in
Balmer’s ranks. Windows was
going the way of the Blackberry …
or was it?

Windows 8 brought a unified
‘metro’ interface that was radically

different from anything they had
done before. Not only did they
launch a version for the PC, there
was also a unified interface for the
mobile world and their own tablet
device. Microsoft, being Microsoft,
did make a simple strategy like this
very complicated to explain, and
pretty soon you had Windows 8
Pro, RT and Phone, and we even
thought we would get an oreo-
flavored version of the OS
sometime later this year.

But never mind all that.
Windows 8 is here, and this week I
decided to dive in deep and install
it on one of my laptops. After
poking it with a stick in a VM on my
Linux machine, I was confident (or
should I say ‘Daring’ ) enough to try
out a full install. And I must say, I’m
quite impressed with Windows 8.
Because it is radically different
from anything Microsoft has done
the last couple of years. It is BOLD!
The Metro interface takes some
getting used to, and everywhere I
hear people spouting tips and
tricks on how to get “past” it and
crawl back to the Start Menu... but
I say to you: embrace it. Give it a
try for a couple of days, and give
your human brain (that has been
accustomed to the Start Button
approach for years) a chance to
adapt. Because, even beyond the
‘in your face’ start menu, the
operating system performs fast
enough, and lets you do what you
want to do. So, as a passionate Mac
and Linux user I dare to say, I like
Windows 8.

And now for me to tell you why.

Written by Knightwise
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Knightwise is a blogger, and
producer of the Knightwise.com
podcast. His website offers hacks,
tips and tweaks for cross-platform
geeks. Knightwisemoves with ease
across Linux, OSX, Windows, OIS,
Android and more.

Windows 8 has one specific
quality that is very VERY important
to an operating system. You hardly
know it’s there. Once you are
working in your application full
screen (or in a window), you do not
notice the operating system is
there. When you NEED it, all you
need to hit is the Windows button
to bring up the menu, or poke the
sides of your screen with your
mouse. And the rest is business as
usual. Using cross platform
applications like Chrome, Firefox,
Thunderbird don’t even give you a
clue that there is in fact a
‘different’ OS running under the
hood than the OSX or Linux flavour
of your choice.

So what’s the deal then?

Humankind is genetically
designed to gang up on a certain
individual and make fun of him.
Microsoft-bashing is SO OLD that
its first instances are now the
subject of historical re-enactments
at county fairs. It’s easy to bash
Microsoft. We always did, so why
not now? The problem with this
approach (and the scoffing at
anything that is ‘different’) is the
fact that it is somewhere based on
bias. And bias is a self-inflicted
restriction of personal freedom.

You decide to dislike something (or
someone) without getting to know
it or him.

A lot of this bias is based on the
fear of change. The uproar – when
Canonical decided to go for the
Unity interface – has still not died
down. The rage against Microsoft –
because of the Metro interface –
will surely echo into eternity. The
reason for this? We are afraid of
change. We are the generation
that is in the transition between
the ‘Classic OS’ with the tiled
windows (not Windows) and the
start buttons. You can find them
back in rock-paintings of the very
first version of Xerox-OS through
many versions of both Windows
and Linux. But that ship has sailed.
We are going to have to adapt and
learn how to work with our
computers differently. The age of
the “visible” OS is over, and, with
the advent of ‘full screen
applications,’ comes the clear
message that the OS is but a
means... not a goal.

So, put down your pitchforks
and step away from the angry mob
to take a good look at Windows 8.
A product from a very ‘old’
company that has been bold
enough to innovate and to change.

To bring something to market that
is not perfect (it has its flaws), but
DIFFERENT from the competition.
And, in times of economic crisis,
that takes balls.

And, before you decide to burn
ME at the stake for my heretical
suggestions, let me finish up and
get out of here. Computers are
about YOU. They are the enablers
of your digital power. They are
coated with the fine slime of an
operating system that should
facilitate the smooth interaction
between you and your
applications. Your applications
should be your toolset to interact
with your data... and whatever you
do with that data should be
directly tied to whatever personal
goal you have. Nowhere, nowhere
in this process should you hinder
yourself by making an uninformed
choice about why you should not
want to use X or Y. Computers are
about YOU, not about computers.

So, let me slide back to another
computer lying around the house.
Whether that’s my Macbook Air
running Ubuntu, my Macbook Pro
running Mountain Lion, I might get
a call on my LG Nexus 4 (running
Android) or pick up my book where
I left off on my iPad .. I don’t care ..

and neither should you. Windows 8
might be your thing, or not (you
should at least try it). As for me, it
has one good quality of a good
operating system: it is invisible. In
the end, I forget what device runs
what OS: in the end, it does not
matter anymore.

mailto:support@penguincsc.co.il
http://Knightwise.com
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BBOOOOKK RREEVVIIEEWW
Written by Copil Yáňez

Publisher: No Starch Press
Pages: 318
Ideal For: Anyone with an interest
in programming, no previous
knowledge necessary

Writing a book on learning to
program has got to be

difficult. Most of us think we know
what programming entails, right?
You type in some goofy-looking
code that tells your computer what
to do and, voila, Skyrim! How hard
can it be?

Very, it turns out. Even the
most basic concepts in
programming (functions, for

example), require careful
explanations that nest comfortably
within one another like coded
Matryoshka dolls. Leave out one of
the dolls and you have an
incomplete arrangement and,
likely, a non-working program.

Now imagine scaling that
complexity down so that a child or,
say, yours truly can understand it.
Now you’re talking orders of
magnitude harder than simply
teaching someone how to code.
Not only do you have to explain
non-intuitive concepts carefully,
you also have to do it in an
entertaining way. It’s like a
pediatric dentist who dresses like a
clown to keep her patient from
running away in tears at the first
sound of drilling.

Cavity prone kids have Dr. Funny
Tooth, and kids interested in
programming have No Starch
Press. Python for Kids basically
dresses up the complexities of
programming in a fun package, and
tries to keep things light, while still
working toward a functional
program.

I am clearly the right
demographic for this book. I’m not
a kid, but I pretty much eat like a
teenager, so it’s almost the same
thing. Plus, I have no working
knowledge of programming, barely
any knowledge about computers,
and only a passing familiarity with
the English language. If Python for
Kids can teach me to program, it’s
quite possible it was written by a
wizard.

The first thing I learned from
this book was that Python was
named after Monty Python, the
English comedy troupe. If that’s all
I’d learned then the book would be
worth its cover price, because I
LOVE Monty Python. But the
learning continued, mostly
because the book is well-written,
engaging, and full of simple words
for simple people like me.

Installing Python for use with
the book seems like it would be
very straightforward. I say seems
because Python came pre-installed
in desktop Ubuntu. Woohoo, I’m a
programmer already!

For non-Ubuntu platforms, the
book offers clear installation
instructions along with screen
caps. Another point for No Starch:
the screen caps in each chapter
typically looked exactly like what I
was seeing on my screen. It’s a
small thing, but I always hate it
when you have to take a moment
to make sure you didn’t do
something wrong because your
picture doesn’t match up with
what’s in the book.

I also had to install the latest
version of Idle (which allows you to
run Python programs) and that
took about 3 seconds. What is
taking so long?! Kidding.

After installing Idle and running
through the first few chapters, I
had my first “Hello World” moment
finished in under 5 minutes. Not
bad, especially when you consider
the attention span of the average
kid, which is on par with the
attention span of the average door
knob. Source: I’m the father of two
kids.

As I progressed through the

PPyytthhoonn FFoorr KKiiddss

http://www.htc.com/www/smartphones/htc-one-s/#specs
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book, I learned about calls,
functions, strings, lists and loops.
Each time a concept was
introduced, I was given a small
snippet of code to enter, and an
explanation of how it worked. The
only time something didn’t work as
expected was when I had entered
the code incorrectly. Since the
code was short and simple, it was
an easy matter of looking through
it to identify the problem.

At this point, allow me to rant
on an issue all programming books
have in common. Why the $#%!
aren’t these books spiral bound so
that I can read them comfortably
while, you know, TYPING ON A
KEYBOARD?!

/rant

Within an hour of opening the
book, I was drawing squares using
the turtle module (which, since it
leaves a trail, is really more
accurately referred to as a snail or
a hobo - presumably those are
different modules we learn about
later).

Each chapter builds on the
previous, and puzzles at the end of
each chapter test your knowledge.
I have to say, these were not

simple recreations of what had
been done already but were,
themselves, extensions of existing
concepts. I actually got a little
clammy-handed working through
them, feeling like a high-school
student taking a pop quiz.
Thankfully, all the answers are
available at
http://nostarch.com/pythonforkids

One of the neat things about
reading beginner programming
books is that you start to see the
evolution of games. As I read
through the creation of classes and
objects, and learned about
functions asking for the user to
input information (age, number,

direction, action, etc), I felt like I
was peeking behind the curtain of
the earliest text-based dungeon-
crawling games I played as a kid.
Modern kids, with their Facetube
and their YouBooks and their X-
Wiis, probably won’t have that
sense of nostalgia, but maybe their
parents will.

By the end of the book, I had a
cute little ball-and-paddle game up
and running and a rudimentary
understanding of the concepts
used in its creation. While I’m not
likely to get called up by Rockstar
Games to work on Grand Theft
Auto VI: Life in Sing-Sing, I do feel
comfortable recommending the

book to interested kids, or picking
up some more beginner
programming books for myself.
There’s nothing quite like seeing
the simple lines of code create
something on the screen and
knowing how and why it happened.

I only have a few complaints
about the book and none of them
would keep me from
recommending it (although they
might be helpful in managing
expectations for potential
readers).

First, of the games you get to
program yourself, the first one, a
ball-and-paddle game, doesn’t
make an appearance until page
190. While all the concepts leading
up to the creation of the game are
explained clearly, and make up the
bulk of what you’re learning, I felt
the game came a little late. An
easy fix for anyone interested in
getting the book who thinks this
might be an issue: simply
download the final version of the
ball-and-paddle game (available
free at the publisher’s website),
run it, and then take a look at the
code. It will seem like gibberish at
first, but, as you go through the
book, you’ll start to see how
certain modules and functions

http://nostarch.com/pythonforkids
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could be used to create the game.

Second, while the book says it’s
for kids, it is important to explain
to young readers what the book
can and cannot do. When I showed
the book to my seven year old, he
got very excited and came up with
a laundry list of things he wanted
to see in the game I was
apparently going to program for
him, none of which I could
accommodate (with the exception
of naming the game Kitchen
Confidential: The Ginsu Offensive -
yeah, my kid is weird). If the target
reader has a deep interest in
programming, and understands
that the final result will be
rudimentary by comparison to
even the simplest iPad app she
might be familiar with, age
shouldn’t be an issue. Otherwise,
younger kids with unreasonable
expectations and/or short
attention spans are not likely to
make it all the way through the
book without boredom or
frustration.

As a side note, whenever
someone is ready to pay me to
write a beginner programming
book using the Diary of a Wimpy
Kid model (basically bathroom
humor and silly cartoons), get in

touch. I have some perfect fart
jokes analogies for explaining
inherited classes.

Until my spiral bound New York
Times Bestseller comes out,
Python for Kids is a perfect
substitute!

Copil is an Aztec name that roughly
translates to “you need my heart for
what again?” His love of women’s
shoes is chronicled at
yaconfidential.blogspot.com. You
can also watch him embarrass
himself on Twitter (@copil).

1166xx1166 SSUUDDOOKKUU

Solutions are on the second last page.

Numbers 0 to 9 and letters A to F are to be filled into the
16x16 grid so that every row, every column, and every
4x4 box contains 0 to 9 and A - F.

Puzzles are copyright, and kindly provided by,
The Puzzle Club - www.thepuzzleclub.com

http://yaconfidential.blogspot.com
http://www.thepuzzleclub.com
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Written by Art Schreckengost

In personal computing, choices
include Windows, Apple, or

Linux, while tablets make do with
iOS, Android, or RT. However,
Google has been working in the
background for the past couple
years to polish its Linux/Android
knock-off, Chrome OS.

Overwhelm is not a word you’ll
find to describe the early $600
Chromebook laptops with their
puny 16GB flash drives, weak ARM
processors normally found in
tablets, and 12-inch screens. Those
on a budget could opt for the
$300+ Chromebox, a desktop
looking suspiciously like a Mac Mini
but still packing the small flash
drive, and requiring that a monitor,
keyboard and mouse be purchased
separately.

No, the flurry of interest
wouldn’t peak until the release of
the $200 Acer C7 Chromebook in
late 2012, sporting a beefier
(although much maligned) Intel
Sandy Bridge Celeron processor
and a more adequate 320GB
spinning hard drive. Same basic
screen size, though.

Since the Acer release sales
have skyrocketed, and finding a
new one can be tough (go to
Google, they still sell them for the
list price instead of the $40 to $50
markup seen elsewhere) but I got
mine the old-fashioned way -- got
it from a kid who bought one and
got another for Christmas. Ah, how
I love a discount!

But does it live up to the hype?
Can Chrome OS be the next best
OS and a serious threat to the big
boys?

Before we get to that question,
it would be wise to give a brief
history of this operating system
and a little background on this sub-
$200 laptop.

First there are two versions,
both based upon current Google
browser offerings. Chromium OS is
the beta testbed that anybody can
attempt to run and/or install on
their computer (have fun, it works
on a limited few). Although
releases are issued daily, it’s
possible to find a dud or two and
they come with zero support and

no guarantees. Those itching to
give Chromium OS a shot can go to
http://chromeos.hexxeh.net/ for
downloads and detailed
instructions.

Chrome OS is the release
product, and isn’t publically
available unless you fork over $200
to $600 for the dedicated desktops
or laptops. It comes with daily
updates (with Chromium you’re
stuck with what you get, it’s never
updated), and security features
such as data encryption, verified
logon and sandboxing.

As for the computer, you’ve
seen it a million times before from
the Acer netbook class. Sporting a
standard 11.6” glossy screen (all
Chromebooks, for whatever
reason, don’t come any larger), it
has 3 USB ports, no optical drive,
HDMI out, wireless (plus an
Ethernet jack), and the ubiquitous
SD card slot. The only Chrome
identifier is the logo on the lid,
otherwise it’s similar to the
Windows 7 or 8 variation seen in
stores for at least $100 more.

It’s the operating system that
warrants the most attention,
though.

Pay close attention MS, Apple
and Linux (you, too, Android, even
if Google does own you), here’s a
lesson for all of you in ease and
efficiency in 3 easy steps.

1. Turn on the power.
2. Choose your wireless signal

or plug in your landline connection.
3. Enter your Gmail account

info, or opt for Guest Mode if you
don’t have Gmail yet.

That’s it. All of maybe 2
minutes, some of which was spent
fishing for my wireless security
code. Add another few minutes as
Chrome syncs the info from your
Gmail account, and you’re out all of
10 minutes.

And what of the reviews that
state Chrome OS boots in under 10
seconds? True, but only for the
flash drive models. Those with
standard hard drives will see that
time doubled, but 20 seconds is
nothing to gripe about, and is still

CChhrroommee OOSS

http://chromeos.hexxeh.net/
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better than even the much
ballyhooed OS X running off a
flash drive.

Truly impressive is the recovery
time from deep sleep mode
(initiated, as always, by closing the
lid on an active session and then
reopening it), which often was less
than a second! Those interested in
shutdown figures will be amazed
at times averaging 2 seconds.

How can this machine be so
quick? First the OS weighs in at just
250MB, which puts it in the
flyweight class along with Puppy
Linux and the like. Second, the
BIOS is locked, prohibiting the
introduction of other operating
systems. Press F12 all you want at
boot, but all it’ll do is ignore you
(in normal operation post-boot,
F12 brings up the page elements
info area). Third, it doesn’t use
programs, it uses apps (more on
this later).

Another reason for the quick
boot time can be attributed to
what you see post-boot, mainly an
abbreviated desktop consisting of
a background image and two
taskbars at the bottom. The left
one is called “launcher” and
consists of app icons. To the right

is an area for wireless signal,
battery life, and the time. In
addition, the photo chosen by the
user is also displayed at the far
right bottom and this acts as a
menu for settings when clicked.

While additional icons can be
added to the launcher, the right
one is set with no adjustments
allowed. In fact, other than
changing position and allowing for
autohide, there is nothing else to
be done with either taskbar.

At this point one should notice
that Chrome OS didn’t get its name
from the metal coating, that honor
comes from the only native
program included -- the Chrome
browser. Everything else you
choose to add is an app that works
in that browser.

Open Chrome (first time users
will get a blank page), and click the
link in the lower right corner for
the Web Store. That opens a bevy
of apps under various categories.
Click on any one of these and the
option to “Add to Chrome”
appears. Click on that and it’s
installed, or is it?

Actually, no. Unlike your
Android tablet where apps are

either installed or held in the
cloud, Chrome OS apps are merely
icons that link to websites. Nothing
is physically installed other than
the linked icons. Those desiring to
install and run programs like
Microsoft Office, Quicken, Skype,
etc, will be dismayed to discover
programs don’t work -- Chrome is it
in that respect; however, there are
workarounds for some programs
and that’ll be discussed shortly.

Might explain why my hard
drive space never decreased.

Expect more of the same with
peripheral devices, too. USB flash
and hard drives work fine along
with some (but not all) DVD
players and mice, but you can kiss
your standard printers and DVD
burners goodbye -- no drivers and
no way of installing them.

But there are other curiosities,
too. For example:

• Apps are thrown into the Apps
library as they are installed, not
alphabetically. After a couple
hundred entries it became so
confusing I had to install yet
another app (Simple Launcher) to
put everything in order (another
hint to Google -- correct this issue).

Also, unlike the Chrome browser
used in Apple, Microsoft, and Linux
systems, this version does not list
installed apps when a blank page is
opened -- everything goes into the
Apps library. If you see an online
screenshot with app icons on the
desktop outside of the browser,
that’s an older version (apparently
discontinued probably because it
required the browser to be
minimized in order to see apps).

• Google recommends creating a
recovery flash drive (a 2GB unit will
do) and there’s a reason. Should
Chrome OS die, the only other way
to get a copy of the recovery file is
to go online, something that may
be a tad difficult if your
Chromebook won’t boot and you
don’t have another computer.
There is no buying a DVD or
bumming someone’s flash drive
since the recovery files differ from
one unit to another; however,
Google is more than happy to give
you a copy for later use.

• The included Chrome browser is
nearly identical to what you’re
probably using now, but it does
have subtle differences. Pinning
tabs (right clicking to reduce them
to ¼ size and leaving them
permanently in the windows area
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for future use) doesn’t work here.
Pin all the tabs you like but they’ll
be gone at next boot (Google is
working on this one). The
minimize/maximize/close buttons
found in most other browsers
don’t exist here, at least not
together. Maximize pulls multiple
duties, but you wouldn’t know that
by just looking, and the only way to
expose the other options is by
doing a mouseover at which time
several choices are presented
(move window right or left,
minimize, restore, and go back).

• Like the idea of a Recycle Bin,
trash can, or whatever your current
OS calls the place to hold deleted
files? Well, there is a slight bent
here. There is no trash receptacle
in Chrome OS itself, it’s in the
Google Drive online. I’ve seen
many complaints about the
inability to retrieve deleted files,
but these users apparently don’t
know its location; however, it is
odd that it doesn’t exist in the OS
but in the cloud.

• There are thousands of apps
available in the Web Store, but
many of them are repeats, just like
in any other app store I’ve seen.
Hardly scientific, but I’d be willing
to bet that nearly a third are

repeats with different names. Yet
other apps linked to websites
offering a boatload of additional
apps in addition to the one I
initially picked, so I guess it all
evens out.

• One could assume that if it’s in
the Web Store, it should work in
Chrome OS; however, that’s not
the case. Much like Linux and
Android, what you see is not
always what you get.

• Updating is done in the
background like Windows, and this
process may produce a noticeable
slowdown in system operations.
Since there is no warning about
background issues, it’s easy to
blame a bad connection when such
may not be the case. Rarely
happens, but it’s an aggravation
when it does.

So, if nearly everything is cloud
based, does that mean your
Chromebook is a brick if no
connection is available?

Contrary to other reviews I’ve
read, not true at all. Go to:
https://chrome.google.com/webst
ore/category/collection/offline_en
abled?utm_source=chrome-ntp-
icon, and you’ll find roughly 500

apps that can be run without
having an active connection (but,
of course, you have to have an
active connection to get apps that
work without one -- how ironic).

So, if you can’t run programs,
and you’re limited to apps, how do
you perform basic office functions
such as word processing?

Enter Google Drive, a poor
man’s version of MS Office. Those
buying new Chrome OS devices get
100GB storage space free for 2
years (at $5 monthly as the normal
fee, that represents a savings of
$120), and with that comes a series
of online programs (or are they
apps, too?) to handle office
functions. This includes Google
Docs, Sheets, Slides, Forms and
Drawings, all self-explanatory in
naming (nobody can accuse Google
of wasting marketing funds on
program titles).

These are worthy competitors
to the likes of LibreOffice, and do
contain most of the basic
functions, with the major
difference being the method of
saving files. For example, instead
of the usual .doc you might find in
Word, Docs uses .gdoc, but files
downloaded away from the Google

drive can be reset to formats
including .docx, .txt, .rtf, and even
.odt (normally associated with
open document formats used by
LibreOffice Writer).

Word of warning, though.
Google Drive’s office offerings
cannot open Open Document
(.odt) files. I found this out when I
created a review in Docs,
downloaded it as .odt and then
decided to go back for editing only
to discover Docs couldn’t open it
again.

One good point about Google
Drive is that you can set the
parameters to allow for offline
editing, with any changes made
without an internet connection
being uploaded the next time one
is present. It does have a tick in
that spreadsheets and drawings
can only be viewed, but not
altered; yet documents and
presentations can be changed.

For those tethered to
LibreOffice, there is the rollApp
app which installs a link to
www.rollapp.com (any OS can use
this site). Pay a visit and you’ll be
greeted by nearly all of the
programs normally found in nearly
all Ubuntu variants, even games,

http://www.chromemote.com/
https://chrome.google.com/webstore/category/collection/offline_enabled?utm_source=chrome-ntp-icon
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but there is a price to pay. Since
these are actual programs
attempting to operate in a browser
window, there is some lag (I could
outtype the cursor), but I got used
to it.

What of music and video files?
Take your choice of Play Movies or
Play Music, and, while either one is
as plain as beige paint, they are
instant (less than 2 seconds from
click to play), and do an admirable
job even if controls are limited to
volume, rewind, reverse, and
stop/play. The only failure
experienced on my end was an
inability to play .flv files, but those
are easily converted to mp3 or
mp4 and then played.

Chances are if you look long
and hard enough in the Web Store,
you’ll find something to replace
your favorite program. For
Facebook and Skype, that
replacement was imo messenger
(all lower case), and, for Quicken or
MS Money, the Finance41 app will
probably do the trick (for those
needing just a checkbook, there
are several nice templates in
Sheets in Google Drive).

Carrying the minimalist
tradition forward, Chrome OS calls

its file manager Files, but the name
isn’t the only thing lacking pizzazz.
Opening Files presents the user
with a gray box consisting of two
folders marked Downloads and
Google Drive.

What about Pictures,
Documents, Videos, and the like?
Sorry, no folders for them, nor can
you add any to the Files area
directly. The only option is to add
subfolders to either Downloads or
Google Drive, or insert a flash drive
or SD card at which point a new
folder is created.

In short, anything you download
or add to your computer from flash
or other external drives goes to
Downloads, never mind the fact
you may not have downloaded any
of it. Anything you want shifted to
the cloud goes to Google Drive
(yes, you can use Dropbox,
Spideroak, and others, too). End of
story.

Ah, but now for the bizarre
aspect of Chrome OS -- printing.
Unlike wired, wireless or
networked printing formats, this
OS uses Google Cloud Print, a
system in which your files are sent
to a server that eventually
connects to your wireless cloud-

aware printer and finishes the job.

Notice the word eventually. In
my testing of two documents (both
just one sentence) one took nearly
5 minutes to finally print, and the
other took almost an hour.
Checking online, I discovered some
complaints that jobs were delayed
nearly a day before finally printing.
Welcome to server based printing –
where you’re at the mercy of
somebody’s server in Timbuktu.

Not only that, but this OS is
snotty about the printers it’ll play
nice with. Go to
http://www.google.com/cloudprint
/learn/printers.html# for a current
and extremely limited listing.
Unless you have one of these
hanging around, the only other
option is to have a Windows, Apple
or Linux computer with the
Chrome browser installed in which
case it can be set to accept your
Chrome OS documents for printing
(not as complicated as it sounds).

Finally, what of reviews that
state Ubuntu 12.04 can run quite
fine on this unit? No fiction there
and it does work, but be aware of
the limitations.

Essentially, you’ll need roughly

3 hours of your time (most of
which is spent downloading a
special version of Ubuntu just for
Chrome OS), and a thorough
review of the tutorial at
http://liliputing.com/2012/11/how-
to-install-ubuntu-12-04-on-the-
199-acer-c7-chromebook.html.

If all goes well, you get
ChrUbuntu, an Ubuntu variant in
which user ID and password are set
to “user”. Otherwise, the only
major difference is the method of
introduction. Since Chrome OS
doesn’t allow for USB or optical
drive booting, this OS is strictly a
“download and immediately
install” affair.

The other limitation has to do
with the locked BIOS. With no dual-
booting allowed, users have to
choose early-on which OS they
desire at boot, and there is no
switching back and forth without
doing a reboot. In fact, to go from
one OS to the next requires code
entry before shutting down, and,
while it’s just one line, it’s not as
easy as keying in “switch to
ChrUbuntu” (see the website
mentioned early).

The good in doing this? Ubuntu
runs quicker on the Chromebook

http://www.chromemote.com/
http://www.google.com/cloudprint/learn/printers.html#
http://liliputing.com/2012/11/how-to-install-ubuntu-12-04-on-the-199-acer-c7-chromebook.html
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than on my dual core i3 pushing
8GB RAM. You also now have
programs instead of apps, so
online access isn’t as critical, and,
since the computer’s hardware is
generic, everything (sound, video,
etc) works perfectly.

The bad? You will have to
remember to key in Ctrl + D at
every boot to bypass the Chrome
OS checker and if you ever desire
to return to Chrome OS by
reinstating the checker, it may very
well blow off the Ubuntu partition.
If you forget to do the keystroke
above, Chrome OS takes an
additional 25 seconds or so looking
for its boot order before giving up
and going to Ubuntu.

So, what’s the final verdict?

If ever a threat to Apple, MS or
Linux existed, this is it.

First, you get a $200 computer
with decent specs that can be
upgraded. If that doesn’t corner
the market, I don’t know what will.
Cripes, you can’t get a decent
tablet for that price, and, if you
want a keyboard, that’ll cost even
more.

Second, it’s fast. Fast to boot,

and fast to operate, even if apps
are only as good as the website
posting them. When I tested the
MS Windows 8 RT tablet, I was
appalled at the lethargic nature of
operations and equalled shocked
by the $600 price tag. Chrome OS
is a blessing by comparison.

Third, Google Drive and its
office suite are a real threat, and I
can see a day when it could
seriously hurt Microsoft’s Office
offering (especially since the price
is free).

Further complicating matters
for the competition is the
persistent rumor that Google may
actually establish Android
compatibility opening up another
million or so apps for general use.
To mix fruit metaphors, that’ll
really upset the apple cart.

But this isn’t to say it’s all
peachy with Chrome OS. It’s fast
and relatively easy to use (my
neighbor still swears trying to
decipher Windows 8 but he caught
on to Chrome OS quickly), but it
still doesn’t use programs, and
many may find the offline
capabilities somewhat lacking. In
addition, the one major thing it
lacks is the ability to handle virtual

machines. Unless you jump
through hoops to add Ubuntu,
you’re pretty much stuck with what
you see. No testing of anything
else -- period.

In addition, Google has taken
what I call the “Atari” position.
Those who may remember the
original Atari gaming systems from
the 80s know they died because
the company made the systems
but ignored those making the
games. Quality control became a
real issue with many games being
absolute garbage. Apps are great
when they do what they are
supposed to, but since Google’s
interest is in the OS, and not what
you run on the app websites,
quality control is somewhat lacking
in this respect. Much like Android,
most of the apps are good to great
but those that are awful can really
ruin your day: a couple have
induced page freezing.

This means it’s not quite up to
standard computer replacement
yet, but it may be quickly.
Remember that many laughed at
the pre-Google Android, and got
caught off-guard when it nearly
creamed the equivalent MS Metro
UI, and Chrome OS could prove to
be the next big breakout.

Although I rarely recommend
computers, and usually
concentrate on the operating
systems, I can see no reason not to
get this inexpensive Chromebook.
If you can find another $200 laptop
that isn’t a beater, refurbished, or
foreign junk posing as a computer,
let me know.

Overall, I give Chrome OS and
the Acer C7 a solid 4 out of 5 stars.

http://www.chromemote.com/
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If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org.
PLEASE NOTE: some letters may be edited for space.

WHERE IS FOSS?

Apps for sale everywhere.
Google Play, Apple's App

Store, and now Ubuntu Software
Centre. Now, I have nothing
against paying for a very good
application, and I also realize that
it takes a lot of time and effort to
create an application. But, there
are a lot of applications out there
that shouldn't cost a cent. Now just
look at Ubuntu Software Centre
and the number of applications
that aren't free that have sprung
up over the last year. My challenge
to the developers out there who
want to create great programs for
Ubuntu and the soon-to-be Ubuntu
phone is: Keep it free and Keep it
open. Then people will want to use
Ubuntu over other devices.

Chris Love

CRON + GUI

I read Jeremy Boden's interesting
article on cron, a useful and

sometimes under-appreciated tool.
For those who prefer to use GUI

editors rather than vi or nano,
readers may be interested to know
how to do this. As Jeremy already
wrote, the way to edit cron is:

crontab -e

However, you can change the
default editor to a GUI one as
follows:

VISUAL=gedit crontab -e

You can replace gedit with
leafpad, or whatever your
preferred editor is. Or, you can set
VISUAL in your .bashrc file to make
this permanent and avoid having
to type it each time.

The two find commands as used
can also be simplified to avoid
using the -exec option, as follows.

find ~/.thumbnails -type f
-atime +7 -delete

find ~/.thumbnails -type f
-atime +7 -ls | more

You could substitute -print for
-ls in the second command –
depending on how you prefer the
output. In certain cases, the

commands as shown are safer than
the original, although this is
unlikely to happen in the
thumbnails folder.

Paddy Landau

SOLYDXK

I saw your facebook post the
other day, and downloaded

SolydK to try it out.

I am not a Linux guru, but I do
like trying new Distros. I have been
using various Linux distros
exclusively for the last 3 years
(hint, NO Windows). I think Solyd is
a great distro. I am using the live
version on my home-built desktop,
after trying it out on my Toshiba
laptop (which worked great).

I like it so much I planned to
install it alongside my Zorin 6,
which has not impressed me much.
Zorin 6 doesn't seem that much
different from version 5, so I was
looking for something new.

One thing that really appeals to

Join us on:

facebook.com/fullcircle
magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

goo.gl/FRTMl

FULL CIRCLE NEEDS YOU!

Without reader input
Full Circle would be an

empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.

See page 29 to read our basic
guidelines. Follow those and
you're almost guaranteed
success.

Have a look at the last page (of
any issue) to get the details of
where to send your
contributions.

mailto:letters@fullcirclemagazine.org
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://linkedin.com/company/full-circle-magazine
http://ubuntuforums.org/forumdisplay.php?f=270
http://goo.gl/FRTMl
https://answers.launchpad.net/ubuntu/+source/linux/+question/195794
http://www.amahi.org


full circle magazine #71 48 contents ^

Full Circle Podcast
Episode 33, With
Added Horsepower

Your hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark
and Freaky Clown

from the
Blackpool (UK) LUG
http://blackpool.lug.org.uk

In this episode we are joined
by Freaky Clown, we talk
about the Ubuntu Phone
release, Linux peripherals
and some events.

LETTERS
me is the fact that, when I hover
over a file, I get a lot more info
than any Ubuntu version I've tried.

I have six old Windows virus
infected hard drives that have
music I want to keep. I used the
recovery disk to get what ended up
being recovered files with not
much info on them. A different and
much, much better info with Solyd.

I read today that, on March 1st,
SolydK is coming out with another
version. I will happily use the live
version till March 1st at which time
Ill install it on my hard drive next
to Zorin 6, and, hopefully, replace
it. I'm not badmouthing any
Ubuntu distro, but am hoping the
best for SolydXK.

Dennis McClellan

Ronnie says: Checknextmonth’s
FCMfora full reviewofSolydXK

from long-time reviewerArt.

TABLE OF CONTENTS

I have been reading this
magazine for many years now

and I keep older issues on my
laptop for reference.

But...sometimes, I want to read
again an article about something
specific I remember having read in
a former issue. Finding the article
again in my collection of FCM issue
is... very tedious and time
consuming!

That is why I had this idea: how
about building a compilation of all
articles published, let's say on a
yearly basis. The list could be
sorted out by themes, making it
easy to find the specific FCM issue
containing that article.

Gilles Tournier

Ronnie says: Goodidea, butwe
beatyou to it. At the top ofthe FCM

site is a button marked'Table of

Contents'which links to:

https://wiki.ubuntu.com/UbuntuMag

azine/FullIssueIndex. It's notbang

up-to-date, but it's close!Gordhas

also just releasedaGoogle Docs file

which lists all how-to's andeven

questions answeredsince the

beginning of(FullCircle) time:

http://goo.gl/C6JiI.

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org

http://blackpool.lug.org.uk
http://fullcirclemagazine.org
https://wiki.ubuntu.com/UbuntuMagazine/FullIssueIndex
http://goo.gl/C6JiI
http://podcast.ubuntu-uk.org/
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QQ&&AA
Compiled by Gord Campbell

If you have Ubuntu-related questions, email them to:
questions@fullcirclemagazine.org, and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

Q Is there a guide to Ubuntu on
the new UEFI motherboards?

A Yes:
https://help.ubuntu.com/com

munity/UEFI

Note that the starting point is
64-bit Ubuntu, versions 12.10 or
12.04.2 -- and the point two is
important.

Q Can I run the latest Adobe
Flash plugin on an old Athlon

XP CPU?

A (Thanks to Troon2 in the
Ubuntu Forums) No, the

plugin requires a CPU instruction
set extension called SSE2, which
the Athlon XP does not include. If
you can find version 10.2 of the
plugin, it should work.

Q How can I download the
"Ubuntu Desktop Manual" so

that I can get a printout?

A (Thanks to deadflowr in the
Ubuntu Forums) You can use

the print option for Ubuntu
Manual:
http://ubuntu-
manual.org/downloads

Q We have a network which
includes Mint 12 and 13, and

Windows XP and 7. The Mint 12
computer has a printer attached,
how can we use that printer from
the other computers?

A There's an excellent writeup
in the community docs:

https://help.ubuntu.com/communi
ty/NetworkPrintingWithUbuntu

When I went through it, the
only discrepancy I found was that
my shared printers appeared after
a few seconds in the Windows "add
a printer" dialogue. The author
calls that a miracle!

Q I'm building a high-
performance computer, what

size SSD do I need?

A If you will also have a hard
drive, 120 GB should be more

than enough. Even if you dual-boot
with Windows, it should be happy
with 80 GB, and then use 40 GB for
/, and put /home on the hard drive.
If you don't plan to have a hard
drive, the important factor is how
much media (pictures, songs and
videos) you expect to have. I
consume a lot of media; my Music
and Pictures folders contain about
15 GB each, but my Videos folder,
and sub-folders, is over 200 GB.

Q How can I run Ubuntu from a
USB stick without the

shopping lens? I have tried a
"persistent" stick, and it's very
slow.

A Install Ubuntu onto the stick,
formatted as EXT2. You might

also want to use "noatime," as
explained here:
http://tldp.org/LDP/solrhe/Securin
g-Optimizing-Linux-RH-Edition-
v1.3/chap6sec73.html

Then, of course, turn off the
shopping lens: sudo apt-get
remove unity-lens-shopping

Q My goal is to install the
original Tomb Raider game

that I have on CD, and that runs on
both Windows 95 and MS-DOS. I
tried to install it under WINE, but
the window immediately closed.

A (Thanks to ibjsb4 in the
Ubuntu Forums) For old DOS

games, use DOSbox, it's in the
software center.

Q I am using ClamAvwith Linux
Mint 14 and have just run it on

some old files that were produced
using Windows MS Word. ClamAv
found viruses in 3 files, and it lets
you quarantine or delete the file
but not to repair it. My question is,
are there no Linux Viruses that we
should worry about?

A There was one Linux trojan
mentioned in the news a few

issues back, and there was a
follow-up describing how to
ensure it can not be installed on
your system. (FCM#67, Q&A)

ClamAV searches for Windows
malware, so you avoid the

mailto:questions@fullcirclemagazine.org
https://help.ubuntu.com/community/UEFI
http://ubuntu-manual.org/downloads
https://help.ubuntu.com/community/NetworkPrintingWithUbuntu
http://tldp.org/LDP/solrhe/Securing-Optimizing-Linux-RH-Edition-v1.3/chap6sec73.html
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Q & A
embarrassment of infecting your
friends. Also, a lot of people run
mail servers on Linux, with
Windows clients. To the best of my
knowledge, Word viruses can not
infect a Linux system.

There are mixed opinions about
Java. I'm no expert, but it appears
that Java is inherently insecure;
many experts suggest removing it
from your system. However, that
means some web sites don't work.
I have it installed on my system,
and visit sites which use it. Note
that Java is not the same as
Javascript, which is OK.

I am convinced that the biggest
danger is responding to fake
emails. If you get an unexpected
email, hover over any links, and you
will find they don't go where they
say they will.

Q How can I run the Shrew Soft
VPN client in Ubuntu 12.10?

A See post 4 of this thread:
http://ubuntuforums.org/sho

wthread.php?t=2078420

Q How can I find
Keyboard/Mouse serial

number or information through
terminal?

A This is from a source who
should know: "keyboards do

not, as a rule, communicate about
what they are to the computer."
Mice are even worse.

Q What do you sages use for
automatic backup of your

systems?

A Good question! I don't use an
automatic backup.

Somewhere around here, I have a
250 GB hard drive which contains
my historical "good stuff." I don't
bother with backup of downloaded
videos; if they all disappeared, I
would say, "oh, well." I use
Dropbox for the stuff I'm currently
working on, which means it gets
synched to my other computers.

The downside of Dropbox: if I
delete a file, it gets deleted
everywhere.

TIPS AND TECHNIQUES
So Easy

Sometime around 2006, I
couldn't resist buying a

Lexmark X1240 multi-function
printer/scanner at Walmart, for
about $60 (Canadian) if memory
serves. It was connected to the XP
machine, and worked fine.
However, it had the usual problem
of ink cartridges drying out when
you don't print much, so by 2009 it
became a scanner, and I bought a
networked Brother laser printer
WITH NO INK CARTRIDGES.

Soon after getting the X1240, I
moved to Ubuntu. When I
upgraded my wife to a newer
computer running Windows 7, I
couldn't find the driver disc for the
Lexmark. OK, go online, I still
couldn't find the drivers. (I later
found not just the drivers, but all
the software which was included
with the multi-function unit -- but
it took several tries.)

Today I wanted to scan
something, so I decided to try the
Lexmark. I connected it to my
computer, turned it on, Linux said,
"a Lexmark 1200 series has
appeared." The ink cartridges have
been dry for years, so I wasn't able
to test that it can actually print,
but I could run "simple scan" and
scan documents to my heart's
content. Total setup time, 30
seconds to plug in the power cord
and the USB cable.

The Lexmark software had an
OCR option, which Simple Scan
doesn't include. However, there
are a couple of programs I could
use to go from image to text, if I
ever need to.

Everything should work this
easily.

http://ubuntuforums.org/showthread.php?t=2078420
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Jennifer is a fine arts student from
the Chicagoland area. You can follow
@missjendie on Twitter or visit her
blog at missjendie.com.

UUBBUUNNTTUU GGAAMMEESS
Written by Jennifer Roger

It’s safe to say that most games
require a certain degree of skill

and precision, but KRUNCH is a
game that takes it up a notch, or
two... or three. KRUNCH is the
debut from LeGrudge & Rugged in
which your goal is to navigate
through deadly obstacles and find
the exit as quickly as you can. It
gets more challenging and
frustrating as you progress, but it’s
always rewarding once you do
advance. KRUNCH certainly
demands precision and speed, but,
without a little patience, you’ll find
yourself hacked in half or
electrocuted in no time.

Oh, speaking of time, your
health gauge gradually decreases

so you’re never without a sense of
urgency. There is a speed boost to
help you outrun enemies, but this
drains your life faster, and it’s
limited to a certain amount that is
reserved strictly for health. In most
levels, monsters are an infrequent
nuisance that offer a slow demise
rather than an abrupt end like
other obstacles.

Never be too certain that
you've made it through a level
unscathed. There are sometimes
unpleasant surprises that await
you. And don't bother trying to
hide in a safe spot, because there
are none in KRUNCH. You can
never let your guard down; only
timing, precision, and quick
thinking will help you survive a

level. But death is certain in this
game, and it’s not shy about
reminding you either. Each time
you die, the following screen
taunts you with stats like how
many times you've died in a certain
amount of time and in what
manner.

Keyboard controls are simple
and intuitive, but, since you’re
technically floating, there is an
added element of movement.
Overdoing it with the space-key
can send you flying into danger.
There’s little room for error so
even subtle movements can have
you bouncing into a wall of spikes.
Luckily, the game supports
gamepads which does add a level
of smoothness to the controls and
worked perfectly with my
Afterglow controller and Xpadder.

Aesthetically, KRUNCH is
extremely polished and well done.
It has great retro graphics, but the
soundtrack is what really stood out
for me. The tracks provide the
intensity and urgency throughout
the stages to keep up the flow of
the game. The music and sounds

are never intrusive or annoying and
always fit the mood of the level.

Overall, KRUNCH proves to be
engaging, fast paced, and
rewarding – even after dying
countless times. With over 100
levels, boss battles, and
leaderboards, there is a lot of
content packed into the game for
extra replayability. KRUNCH is
available now for Windows, Mac,
and Linux, at
http://krunchgame.com/. You can
purchase the game only for $9.99,
or you can get the game and
soundtrack for $13.99.

Pros: Challenging yet rewarding,
great soundtrack
Cons: Sensitive controls

KKRRUUNNCCHH

http://missjendie.com
http://krunchgame.com/
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LLIINNUUXX CCEERRTTIIFFIIEEDD
Written by Richard Philip Witt

Richard Philip Witt, 30, living in
Switzerland. I’ve been using Ubuntu
desktop and server for roughly 2
years. But only for the basics. Now I
want to discover its capabilities. Any
mentors out there? Email me:
chilledwinston2@hotmail.com.

Let's face it, when done poorly,
learning can be very dull

indeed. My uninspired flashcard
approach had been slowing my
progress and, last month, brought
it to a grinding halt. Hence my
missing article from FCM#70. As it
happens, this in itself is quite
ironic; I initially decided to write
monthly articles to act as a check,
to discipline myself to cover
material in order to be able to
report on it. Needless to say, it
failed, but at the same time it
forced me to rethink my approach
to learning, and the tentative
solution came in the form of 'Linux
from Scratch'.

PROWESS

To cover it briefly, as the name
suggests, Linux from Scratch (LFS)
is a guide to building your own
linux distribution from the ground
up. What I've realised is that sexy is
motivating (yes engineering an
operating system is sexy). As the
adage goes: "If you want to build a
ship, don't drum up the men to
gather wood, divide the work, and

give orders. Instead, teach them to
yearn for the vast and endless sea."

Before you can build your LFS
operating system, you must
partition off about 10-15GB.* This
task brought about a great deal of
LPIC-relevant learning (Linux
Professional Institute
Certification). I learned how to use
the fdisk and parted commands
and to interpret their outputs.
Output interpretation requires a
basic understanding of file
systems. This partition-task
focussed my reading, and here
LPIC-relevant texts are valuable.
They give plenty of background
information and clearly explain the

command and its options. There's a
second salient point here. Within
the confines of my everyday
Ubuntu-ing (reading email, playing
chess, internet, FCM, watching
films), I would never come to
partition a hard drive. It just
wouldn't enter my horizon, and
arbitrarily exploring partitioning
seems abstract and contrived. On
the other hand, when I successfully
partition my hard drive for my own
operating system, I gain a sense of
achievement. In short, LPIC is
designed to train up System
Admins: it's a professional
qualification. Until command-line
LPIC training materials exist,
making use of LFS to learn about

partitioning and filesystems is a
pragmatic option.

*I haven't successfully created the
partition yet. When I installed Ubuntu
12.04 LTS, I created one huge ext4
partition (110GB), and one swap partition
(10GB). I never thought I'd need to
partition further. Another lesson learned.

mailto:chilledwinston2@hotmail.com
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MMYY DDEESSKKTTOOPP

This is my desktop screenshot. As you can see, my desktop
uses Cairo Dock at the bottom and Conky on the right.

OS: Ubuntu 12.10 (quantal) 32-bit Kernel Linux 3.5.0-21-
generic
GNOME 3.6.0
Processor: Intel Core i3-2100 CPU @ 3.10GHz x 2
Memory: 3.9 GiB
Theme: Mac-os-x-theme
Cursor theme: Macbuntu-Xii-Cursor
Icon theme: Matrilineare
GTK+Theme: Mac-os-x-theme

Halidi Doank

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

Greetings from Ecuador!
I'm new to Linux. Just started last September with Ubuntu
12.04 LTS (Precise Pangolin) after Windows 7 crashed. I'm still
learning the basics but honestly I can say I'm feeling satisfied.
My laptop is much faster than before.

My specs:
Laptop: Dell Inspiron with Unity
Memory: 2 GB
Processor: Intel® Core™ i3 CPU M 380 @ 2.53GHZ x 2
Graphics: Intel® Ironlake Mobile
Disk: 313.1 GB

Francisco J. Robles

mailto:misc@fullcirclemagazine.org
http://www.gothicwalpapers.com
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MY DESKTOP

Long time reader; first time contributor.

I have been using Ubuntu since 7.04, and, apart from a brief spell
with Bodhi (which I loved, but which required a little more
maintenance than I like), have been an Ubuntu user all that time.

I have used the BUUF icon set almost as long. It is beautiful, and
it makes Unity look a little less glib and a little more homely. I
found the wallpaper on Deviant art, and have stuck with it even
though it's designed for Lucid Lynx and I'm now on 12:10. I love
the texture of it, and the Ubuntu circle has never looked more
beautiful.

It's not flashy, but this is my desktop, and it feels like home.

Peter Mason

I run Ubuntu 12.04 on my laptop ASUS A42N. It uses LXDE
and Metacity for window manager. Why did I choose
Metacity? Because I think it has 'more colors' than the
default LXDE's Openbox.

gtk theme : Ambiance
Metacity : Ambiance Squared
Icons: Faenza

Husni Amri
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PUZZLE SOLUTIONS
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Codeword and 16x16 Suduko puzzles are
copyright, and kindly provided by, The Puzzle
Club - www.thepuzzleclub.com
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http://www.thepuzzleclub.com
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HHOOWW TTOO CCOONNTTRRIIBBUUTTEE
Full Circle Team

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Lucas Westermann,
Gord Campbell, Robert Orsino,
Josh Hertel, Bert Jerred

Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

FULL CIRCLE NEEDS YOU!
A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

FCM#72
Deadline:
Sunday 07th Apr. 2013.
Release:
Friday 26th Apr. 2013.

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Google Currents - Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app) and
you'll be able to add issues 55+. Or, you can click the links on the FCM download pages.

Ubuntu Software Centre - You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full
circle', choose an issue, and click the download button.

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Ubuntu One - You can now have an issue delivered to your free Ubuntu One space by clicking the 'Send to Ubuntu One' button
which is available on issues 51+.
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